
 

 CHAPTER 5  

 

SPREADSHEETS 

 5.1  SPREADSHEET – AN OVERVIEW 

A spreadsheet is a document that stores data in a grid of horizontal rows and vertical 

columns. Spreadsheets are primarily used to work with numbers and text. A spreadsheet is 

divided into a series of rows and columns to store the information. Rows are typically 

labeled using numbers (1, 2, 3, etc.), while columns are labeled with letters (A, B, C, etc.). 

Individual row/column locations, such as C3 or B12, are referred to as cells. In a spreadsheet 

application, each value sits in a cell. The relationships between cells are called formulas, and 

the names of the cells are called labels.  

Once you have defined the cells and the formulas for linking them together, you can 

enter your data. You can then modify selected values to see how all the other values change 

accordingly.  

Most spreadsheet applications are multidimensional, meaning that you can link one 

spreadsheet to another. A three-dimensional spreadsheet, for example, is like a stack of 

spreadsheets all connected by formulas. A change made in one spreadsheet automatically 

affects other spreadsheets. The most popular examples of this type of software are Lotus, 

MS-Excel. 

Note: A spreadsheet document is often called a worksheet. 

5.1.1 Features of Spreadsheet 

Spreadsheet software provides all the features you need to create a professional looking 

spreadsheet. Some of the main features of a spreadsheet program are: 
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 It provides a standard grid, which may be scrolled and zoomed. Text, numeric or 

date values or formulas may be entered into the selected cell through the formula 

bar at the top of the screen. 

 Cells may be formatted using the format pages, which let you specify the font style, 

borders, text and background colors, the size of cells and text alignment within the 

cells. 

 Spreadsheet provides support for multiple sheets within a workbook. When you 

press the worksheet button, worksheets are presented in a horizontally scrollable 

page, allowing you to quickly flick between all the worksheets in the workbook. 

 A worksheet may be selected simply by tapping on it. You can create new 

worksheets and delete or rename existing worksheets. 

 Spreadsheet provides the ability to search the worksheet for any phrase, number or 

other text, letting you easily scroll between search results. It is also possible to sort a 

range of cells by any row or column. 

 Spreadsheet supports a variety of functions used to perform basic calculations based 

on parameters set by the user. 

 Spreadsheets can be integrated for use with other software programs. One example 

is a mail merge. A spreadsheet can be created with the names and addresses of 

various individuals, and a mail merge can be used to fill in text boxes into form 

letters. 

 Data in spreadsheets can be displayed in a graphic form. Spreadsheets allow the 

numerical data in the cells to be displayed as a graph or chart. 

5.1.2 Applications of Spreadsheet 

Some of the applications of a spreadsheet program are as under: 

 A spreadsheet allows users to enter and calculate numerical data. 

 Using a spreadsheet greatly increases productivity for anyone who needs to manage 

receipts, create budgets, generate financial reports or even keep track of inventories. 

 A spreadsheet is a useful tool for sorting and analyzing data.  

 Complex calculations can be performed very quickly. 

 Professional looking graphs and charts can be created very quickly from a range of 

data which allows you to view the data pictorially. 

 Easy to make changes and corrections to data on the worksheet. Calculation is 

always accurate, provided that data and formulae entered are correct. 
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 5.2  MICROSOFT EXCEL 

Microsoft Excel is spreadsheet software in the Microsoft Office Suite widely used to 

perform mathematical calculations. The data is spread in a tabular form consisting of rows 

and columns. It provides built-in features and tools such as formulas, functions and data 

analysis tools that make it easier to work with large amount of data. 

Spreadsheets are primarily used to work with numbers and text. A file of MS-Excel is 

called a workbook and it contains multiple worksheets or spreadsheets. A worksheet is 

divided into a series of rows and columns to store the information.  

MS-Excel helps us to: 

 Arrange data in an organized way 

 Perform mathematical calculations 

 Compare data through charts 

 Sort data for better analysis 

 Compare two workbooks side by side 

Microsoft Excel or MS-Excel allows you to store, organize, and analyze numerical and 

text data. You can use this robust application to enter numerical values or data into the rows 

or columns of a spreadsheet, and to use these numerical entries for calculations, charts, 

formulas, statistical analysis, etc. 

 5.3  EXCEL 2010 

Excel 2010 is the spreadsheet software in the Microsoft 2010 Office Suite. It allows you to 

store, organize, and analyze numerical and text data. You can use this robust application to 

enter numerical values or data into the rows or columns of a spreadsheet, and to use these 

numerical entries for calculations, charts, formulas, statistical analysis, etc. Whether you are 

keeping a budget, organizing a training log, or creating an invoice, Excel 2010 makes it easy 

to work with different types of data. 

Excel 2010 enables you to build a calculation by creating a formula that specifies the 

values to calculate and which mathematical operators to use to perform the calculation. 

Excel also offers functions - predefined formulas that perform more complex calculations. 

5.3.1 Features of Excel 2010 

Excel 2010 is a powerful tool for analyzing, sharing, and managing information to help 

you make more informed decisions. 
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Some of the important features of Excel 2010 are as under: 

 Results-oriented user interface: Excel 2010 provides results-oriented user interface. 

Based on the job you need to accomplish, whether it is creating a table or writing a 

formula, Excel 2010 presents you with the appropriate commands. 

 Organize, and explore massive data sets within significantly expanded 

spreadsheets: Excel 2010 supports spreadsheets up to 1 million rows by 16,000 

columns in size eliminating the need to work within multiple spreadsheets or other 

applications you need to analyze large amounts of information. 

 Improved and powerful support for working with tables: Excel 2010 has improved 

support for tables allowing you to create, format, expand, and refer to tables within 

formulae. 

 Save as XPS or PDF for easier sharing: Convert your spreadsheet to XML Paper 

Specification (XPS) or Portable Document Format file (PDF) to create a fixed version 

of your file for easier sharing. 

 Share Spreadsheets and Business Information with Others: Excel 2010 makes 

sharing spreadsheets and business information easier. 

 Communicate your analysis in professional-looking charts: Build professional-

looking charts faster with fewer clicks using charting tools in the Excel 2010 user 

interface. 

 Importing data from external sources: In Excel 2010, data can be imported from 

external sources such as a database. Data can also be imported from formatted tables 

and reports, which do not have a regular grid structure. 

 Formula Auto complete: Excel 2010 automatically suggests function names, 

arguments and named ranges, and automatically completing them if desired, based 

on the characters entered. 

 Pivot tables: Pivot tables are used to create analysis reports out of sets of data, can 

now support hierarchical data by displaying a row in the table with a "+" icon, 

which, when clicked, shows more rows regarding it, which can also be hierarchical. 

 5.4  STARTING EXCEL 2010 

To Start Excel 2010: 

 Click on the Start button, point to All Programs then Microsoft Office and click on 

Microsoft Excel 2010. 

 The first screen that you will see a new blank worksheet that contains grid of cells. 
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This grid is the most important part of the Excel window. It's where you will 

perform all your work, such as entering data, writing formulas, and reviewing the 

results. 
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Fig. 5.1 (Micros oft Exce l W indow  or Scre e n Layout) 

5.4.1 EXCEL 2010 SCREEN ELEMENTS 

Let us discuss the various important screen elements of Excel 2010. 

 File Tab: The File tab replaces the Office button from Excel 2007. You can click it to 

check Backstage view, which is the place to come when you need to open or save files, 

create new sheets, print a sheet, and do other file-related operations. 

 Quick Access Toolbar: A small toolbar you will find just above the File tab contains 

shortcuts for some of the most common commands such as Save, Undo, and Redo 

buttons.  

 Ribbon: A combination of old versions menu bar and toolbar, arranged into a series of 

tabs. Ribbon contains commands organized in three components: 

 Tabs: Tabs appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert and Page Layout are the examples of ribbon tabs. 

(i) Groups: Groups organize related command. Each group name appears below 

the group on the Ribbon. For example: Group of commands related to fonts 
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(Font group) or group of commands related to alignment (Paragraph group) 

etc. 

(ii) Commands: Commands appear within each group as mentioned above. For 

example: Bold, Italic and Underline are the commands appear under Font group 

of Home tab. 

 Title Bar: Title bar lies at the top of the window. It shows the program and 

document titles. 

 Name Box: Displays the address of the current active cell where you work in the 

worksheet. 

 Formula Bar: Displays the address of the active cell on the left edge, and it also 

shows you the current cell's contents. 

 Sheet Tabs: Excel 2010 contains 3 blank worksheet tabs by default. Click on the 

intended tab will go to the particular worksheet. 

 Status Bar: This displays sheet information as well as the insertion point location. 

From left to right, this bar can contains the total number of pages and words in the 

document, language etc. 

 Zoom Control: Use to zoom the Excel screen in or out by dragging the slider. 

 View Buttons: The group of three buttons located to the left of the Zoom control, lets 

you switch among Excel’s various sheet views. 

o Normal Layout view: This displays page in normal view. 

o Page Layout view: This displays pages exactly as they will appear when printed. 

This gives a full screen look of the document. 

o Page Break view: This shows a preview of where pages will break when printed. 

 Sheet Area: The area where you enter data. The flashing vertical bar is called 

the insertion point and it represents the location where text will appear when you 

type. 

 Row Bar: Rows are numbered from 1 onwards and keeps on increasing as you keep 

entering data.  

 Column Bar: Columns are numbered from A onwards and keeps on increasing as 

you keep entering data. After Z, it will start series of AA, AB and so on. 

 5.5  WORKSHEET, WORKBOOK AND CELL 

A worksheet is the grid of cells where you can type the data. The grid divides your 

worksheet into rows and columns.  
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Columns are identified with letters (A, B, C ….), while rows are identified with numbers 

(1, 2, 3 ….). 

The worksheets in turn are grouped together into a workbook. By default each 

workbook in Excel 2010 contains 3 blank worksheets, which are identified by tabs 

displaying along the bottom of your screen. The first worksheet is called Sheet1, the next is 

Sheet2 and so on as shown below: 

 

Fig. 5.2 (W ork s h e e ts  in a W ork book ) 

 Cells are the basic building blocks of a worksheet. Each rectangle in a worksheet is 

called a cell. A cell is the intersection of a row and a column i.e. a cell is identified by 

column and row.  

 

Fig. 5.3 (Ce ll in a W ork s h e e t) 

Each cell has a name, or a cell address based on which column and row it intersects. The 

cell address of a selected cell appears in the name box. 
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Fig. 5.4 (Ce ll Addre s s ) 

To Select a Cell: 

 Click a cell to select it. When a cell is selected, you will notice that the borders of the 

cell appear bold  and the column heading and row heading of the cell are 

highlighted. 

 Release your mouse. The cell will stay selected until you click another cell in the 

worksheet. 

To Select Multiple Cells: 

 Click and drag your mouse until all of the adjoining cells you want are highlighted. 

 

Fig. 5.5 (Se le cting Multiple  Ce lls ) 

 Release your mouse. The cells will stay selected until you click another cell in the 

worksheet. 

Note: The active cell is the cell that receives the data or command you give it.  

 5.6  WORKING WITH ROWS AND COLUMNS 

Microsoft Excel represents the data in tabular format consisting of rows and columns. 

Row runs horizontally while Column runs vertically. Each row is identified by row number 
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(like- 1, 2, 3, 4, 5, 6, 7….. so on) and each column is identified by column header (like- A, B, 

C, D, E, F ….. so on). 

Note: In Excel 2010, row numbers ranges from 1 to 1048576; in total 1048576 rows, and 

columns ranges from A to XFD; in total 16384 columns. 

By default, every row and column of a new workbook is set to the same height and 

width. Excel allows you to modify column width and row height in different ways. 

5.6.1 CHANGING COLUMN WIDTH 

In Excel worksheets, if the data being entered in a cell is wider or narrower than the 

default column width, you can adjust the column width so it is wide enough to contain the 

data. 

To Modify Column Width: You can adjust or modify the column width manually or use 

AutoFit. 

(i) To Manually Adjust a Column Width: 

 Place your mouse pointer to the right side of the gray column header.  

 The mouse pointer changes to the adjustment tool (double-headed arrow). 

 

Fig. 5.6 (Adjus t colum n w idth  m anually) 

 Drag the Adjustment tool left or right to the desired width and release the mouse 

button. 

(ii) To AutoFit the Column Width: 

 Place your mouse pointer to the right side of the column header.  

 The mouse pointer changes to the adjustment tool (double-headed arrow). 

 Double-click the column header border.  

 Excel "AutoFits" the column, making the entire column slightly larger than the 

largest entry contained in it.  
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(iii) To Set Column Width with a Specific Measurement: 

 Select the columns you want to modify. 

 Click on Home tab  Cells group  Format command. The format drop-down 

menu appears. Select Column Width. 

 

Fig. 5.7 (Colum n W idth  Option) 

 The Column Width dialog box appears. Enter a specific measurement. 

 

Fig. 5.8 (Colum n W idth  Dialog box) 

 Click OK. The width of each selected column will be changed in your worksheet. 

5.6.2 CHANGING ROW HEIGHT 

Changing the row height is very much like adjusting a column width. There will be 

times when you want to enlarge a row to visually provide some space between it and 

another row above or below it. 

To Modify Row Height: You can adjust or modify the row height manually or use 

AutoFit. 

(i) To Manually Adjust a Row Height: 

 Place your mouse pointer to the lower edge of the row heading you want to adjust.  

 The mouse pointer changes to the adjustment tool (double-headed arrow). 

 Drag the Adjustment tool up or down to the desired height and release the mouse 

button. 
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Fig. 5.9  (Adjus t row  h e igh t m anually) 

(ii)  To AutoFit the Row Height: 

 Place your mouse pointer to the lower edge of the row heading you want to adjust.  

 The mouse pointer changes to the adjustment tool (double-headed arrow).  

 Double-click to adjust the row height to "AutoFit" the font size.  

 Excel “AutoFits” the row, making the entire row slightly larger than the largest entry 

contained in the row.  

(iii) To Set Row Height with a Specific Measurement: 

 Select the rows you want to modify. 

 Click on Home tab  Cells group  Format command. The format drop-down 

menu appears. Select Row Height. 

 

Fig. 5.10 (Row  H e igh t Option) 

 The Row Height dialog box appears. Enter a specific measurement. 

 

Fig. 5.11 (Row  H e igh t Dialog box) 

 Click OK. The selected rows heights will be changed in your spreadsheet. 
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5.6.3 INSERT ROWS 

To Insert Rows: 

 Click anywhere in the row below where you want to insert the new row.  

 Click on Home tab  Cells group  Insert command. 

 

Fig. 5.12 (Ins e rt com m and to ins e rt a row ) 

 The new row appears in your worksheet.  

5.6.4 INSERT COLUMNS 

To Insert Columns: 

 Select the column to the right of where you want the new column to appear. For 

example, if you want to insert a column between A and B, select column B. 

 Click on Home tab  Cells group Insert command. 

 

Fig. 5.13 (Ins e rt com m and to ins e rt a colum n) 

 The new column appears in your worksheet.  

5.6.5 INSERT CELLS 

To Insert Cells: 

 Select the cell or range of cells where you want to insert new cells. This could be a 

single cell or a group of cells. 

 Right-click on the selected cell(s), and from the context menu that appears, choose 

"Insert". 

    OR 

 Click on Home tab  Cells group  Insert command and select "Insert Cells". 
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Fig. 5.14 (Ins e rt com m and to ins e rt a ce lls ) 

 In the Insert dialog box that appears, you can choose the type of insertion: 

 

Fig. 5.15 (Ins e rt dialog box) 

o Shift cells right: This option moves the existing cells to the right to make room 

for the inserted cells. 

o Shift cells down: This option moves the existing cells down to make room for 

the inserted cells. 

o Entire row: This option inserts an entire row above the selected cells. 

o Entire column: This option inserts an entire column to the left of the selected 

cells. 

 After selecting the desired insertion type, click the "OK" button. The cells will be 

inserted, shifting the existing cells as per your selection. 

5.6.6 DELETE ROWS 

To Delete Rows: 

 Select the rows you want to delete. 

 Click on Home tab  Cells group  Delete command. 
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Fig. 5.16 (De le te  com m and to de le te  a row ) 

 The rows are deleted from your worksheet. 

5.6.7 DELETE COLUMNS 

To Delete Columns: 

 Select the columns you want to delete. 

 Click on Home tab  Cells group  Delete command. 

 

Fig. 5.17 (De le te  com m and to de le te  a colum n) 

 The columns are deleted from your worksheet. 

5.6.8 DELETE CELLS 

To Delete Cells: 

 Select the cell or range of cells you want to delete. This could be a single cell or a 

group of cells. 

 Right-click on the selected cell(s), and from the context menu that appears, choose 

"Delete". 

                                                                        OR 

 Click on Home tab  Cells group  Delete command and select "Delete Cells". 

 
Fig. 5.18 (De le te  com m and to de le te  ce lls ) 
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 In the Delete dialog box that appears, you can choose the type of deletion: 

 

Fig. 5.19  (De le te  dialog box) 

o Shift cells left: This option shifts the remaining cells to the left, filling the gap 

created by the deleted cells.  

o Shift cells up: This option shifts the remaining cells up, filling the gap created by 

the deleted cells. 

o Entire row: This option deletes the entire row containing the selected cells. 

o Entire column: This option deletes the entire column containing the selected 

cells. 

After selecting the desired deletion type, click the "OK" button. The cells will be 

deleted, and the remaining cells will be shifted accordingly. 

5.6.9 WRAPPING TEXT AND MERGING CELLS 

If a cell contains more text than can be displayed, you can choose to wrap the text within 

the cell or merge the cell with empty adjoining cells. Wrap text to make it display on 

multiple lines of the cell. Merge cells to combine adjoining cells into one larger cell. 

To Wrap Text: 

 Select the cells with text that you want to wrap. 

 Select the Home tab  Alignment group  Wrap Text command. 

 

Fig. 5.20 (W rap Te xt com m and) 

 The text in the selected cells will be wrapped in your worksheet. 
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To Merge Cells using the Merge & Center command: 

 Select the cells you want to merge. 

 Select the Home tab  Alignment group  Merge & Center command. 

 

Fig. 5.21 (Me rge  &  Ce nte r com m and) 

 The selected cells will be merged, and the text will be centered. 

 5.7  CREATING A WORKBOOK 

Excel files are called workbooks. Each workbook holds one or more worksheets (also 

known as spreadsheets). 

To Create a New Workbook: 

 Click the File tab to move on Backstage view. 

 Select New. 

 Select Blank workbook under Available Templates. 

(It will be highlighted by default.) 

 Click Create. A new blank workbook appears in the Excel window. 

 

Fig. 5.22 (Cre ating a W ork book ) 
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 5.8  OPENING A WORKBOOK 

There may be a situation when you open an existing workbook and edit it partially or 

completely. 

To Open an Existing Workbook: 

 Click the File tab to move on Backstage view. 

 Select Open. The Open dialog box appears. 

 

Fig. 5.23 (Ope ning a W ork book : Ope n Dialog box) 

 Select your desired workbook and then click Open. 

 5.9  ENTERING AND EDITING DATA 

In the cell(s) of worksheet(s), the data that you enter can be numbers, text, dates, or 

times. 

To Enter Text or Numbers: 

 Left click a cell to select it. Each rectangle in the worksheet is called a cell. As you 

select a cell, the cell address appears in the Name Box. 

 

Fig. 5.24 (Se le cting a Ce ll to Ente r Data) 
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 Enter text or numbers into the cell using your keyboard. The entered data appears in 

the cell and in the formula bar. 

 

Fig. 5.25 (Ente r Data into Ce ll) 

To Enter Date or Time: 

 On the worksheet, click a cell. 

 Type a date or time as follows: 

o To enter a date, use a slash mark or a hyphen to separate the parts of a date; for 

example, type 9/5/2002 or 5-Sep-2002. 

o To enter a time that is based on the 12-hour clock, enter the time followed by a 

space, and then type a or p after the time; for example, 9:00 p. Otherwise, Excel 

enters the time as AM. 

 To enter the current date and time, press Ctrl+Shift+; (semicolon). 

To Edit or Delete Data: 

 Select the cell. 

 Press the Backspace key on your keyboard to delete text and make a correction. 

 Press the Delete key to delete the entire contents of a cell. 

Note: You can also make changes to and delete text from the formula bar. Just select the 

cell and place your insertion point in the formula bar. 

 5.10  SAVING A WORKBOOK 

Once you are done with typing in your new excel sheet, it is time to save your 

sheet/workbook to avoid losing work you have done on an Excel sheet.  

To Save the Workbook: 

 Click the File tab and select Save or Save As option. 

o Save As allows you to name the file and choose a location to save the 

spreadsheet. Choose Save As if you would like to save the file for the first time 

or if you would like to save the file as a different name.  

o Select Save if the file has already been named. 
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File  tab Save  As  

 

Fig. 5.26 (Save  a w ork book ) 

 Select a folder where you would like to save the sheet, Enter file name which you 

want to give to your sheet and Select a Save as type, by default it is .xlsx format. 

 Finally, click on Save button and your sheet will be saved with the entered name in 

the selected folder. 

  5.11  CREATING A NEW WORKSHEET 

By default each workbook in Excel 2010 contains 3 blank worksheets named as, Sheet1, 

Sheet2 and Sheet3. 

 
Fig. 5.27 (De fault W ork s h e e ts  in a W ork book ) 

But suppose that you want to start another new worksheet while you are working on 

another worksheet, or you closed already opened worksheet and want to start a new 

worksheet.  
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To Create a New Worksheet: 

 Right Click the Sheet Name and select Insert option. 

 

Fig. 5.28 (Cre ate  a Ne w  w ork s h e e t) 

 Now you will see the Insert dialog box with select Worksheet option as selected 

from the General tab. Click Ok button. 

 

Fig. 5.29  (Cre ate  a Ne w  w ork s h e e t: Ins e rt dialog box) 

 A new blank sheet will be displayed and you can start typing your text. 
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Fig. 5.30 (Cre ate  a Ne w  w ork s h e e t: A Ne w  blank  s h e e t) 

 5.12  CLOSING A WORKBOOK 

Closing a workbook simply removes the file from your screen but keeps your Excel 2010 

program running so you can edit or open another file. If you have not saved your file, 

closing a file will prompt you to save your changes. 

To Close a Workbook: 

 Click the File tab. 

 The Backstage View appears. 

 Click Close. 

If you have not saved your file, a dialog box appears asking whether you want to save 

your changes. 

 Click Save to save your changes, Don’t Save to discard any changes, or Cancel to 

keep your file open. 

If you click either Save or Don’t Save, Excel 2010 closes your file. 

     OR 

Click the Close Button as shown below: 
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Fig. 5.31 (Clos ing a W ork book ) 

 5.13  FORMATTING WORKSHEETS 

Once you have entered information into a worksheet, you will need to be able to format it. 

To Format Text in Bold or Italics: 

 Left-click a cell to select it or drag your cursor over the text in the formula bar to 

select it. 

 Click the Bold or Italics command. 

 

Fig. 5.32 (Form atting Te xt in a W ork s h e e t: Bold or Italic) 

Note: You can select the entire column and row, or specific cells. 

(i) To select the entire column, just left-click the column heading and the entire 

column will appear as selected. 

(ii) To select the entire row, just left-click the row heading and the entire row will 

appear as selected. 

(iii) To select the specific cells, just left-click a cell and drag your mouse to select the 

other cells. Then, release the mouse button. 



 Spreadsheets  5.23   

To Format Text as Underlined: 

 Select the cell or cells you want to format.  

 Click the drop-down arrow next to the Underline command. 

 Select the Single Underline or Double Underline option. 

 

Fig. 5.33 (Form atting Te xt in a W ork s h e e t: Single  Unde rline  or Double  Unde rline ) 

To Change the Font Style: 

 Select the cell or cells you want to format.  

 Left-click the drop-down arrow next to the Font Style box on the Home tab. 

 Select a font style from the list. 

 

Fig. 5.34 (Form atting Te xt in a W ork s h e e t: Ch ange  Font Style ) 

Note: As you move over the font list, the Live Preview feature previews the font for you 

in the spreadsheet. 

To Change the Font Size: 

 Select the cell or cells you want to format. 

 Left-click the drop-down arrow next to the Font Size box on the Home tab. 

 Select a font size from the list. 

 

Fig. 5.35 (Form atting Te xt in a W ork s h e e t: Ch ange  Font Siz e ) 
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To Change the Text Color: 

 Select the cell or cells you want to format. 

 Left-click the drop-down arrow next to the Text Color command. A color palette 

will appear. 

 Select a color from the palette. 

 

Fig. 5.36 (Form atting Te xt in a W ork s h e e t: Ch ange  Te xt Color) 

OR 

 Select More Colors. A dialog box will appear.  

 Select a color. 

 Click OK. 

To Add a Border: 

 

Fig. 5.37 (Form atting Te xt in a W ork s h e e t: Add a Borde r for th e  ce ll(s )) 
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 Select the cell or cells you want to format. 

 Click the drop-down arrow next to the Borders command on the Home tab. A menu 

will appear with border options. 

 Left-click an option from the list to select it. 

To Add a Fill Color: 

 Select the cell or cells you want to format.  

 Click the Fill command. A color palette will appear. 

 Select a color. 

 

Fig. 5.38 (Form atting Te xt in a W ork s h e e t: To add a Fill Color for th e  ce ll(s )) 

 OR 

 Select More Colors. A dialog box will appear.  

 Select a color. 

 Click OK. 

 5.14  MANAGING WORKSHEETS 

In a workbook, the tabs displayed at the bottom of the screen are named Sheet1, Sheet2 

and Sheet3. These are not very informative names. Excel allows you to define a meaningful 

name for each worksheet in a workbook so that you can quickly locate information. 

5.14.1 RENAMING A WORKSHEET 

To Rename a Worksheet: 

 Double-click the sheet tab to select it. The text is highlighted by a black box. 
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Fig. 5.39  (Re nam ing a w ork s h e e t) 

OR 

 Right click on the sheet tab and select Rename option from the shortcut menu. The 

text is highlighted by a black box. 

 

Fig. 5.40 (Re nam ing a w ork s h e e t th rough  Sh ortcut m e nu) 

 Type a new name for the worksheet. 

 

Fig. 5.41 (Se tting ne w  nam e  for th e  w ork s h e e t) 

 Press the Enter key.  

5.14.2 INSERTING A WORKSHEET 

By default, each new workbook in Excel defaults to three worksheets named Sheet1, 

Sheet2 and Sheet3. You have the ability to insert new worksheets if needed. 

To Insert a New Worksheet: 

 To quickly insert a new worksheet at the end of the existing worksheets, click the 

Insert Worksheet tab at the bottom of the screen. 

 

Fig. 5.42 (Ins e rt a Ne w  w ork s h e e t: Us ing Ins e rt W ork s h e e t tab) 



 Spreadsheets  5.27   

 To insert a new worksheet in front of an existing worksheet, select that worksheet 

and then, on the Home tab, in the Cells group, click Insert, and then click Insert 

Sheet. 

 

Fig. 5.43 (Ins e rt a Ne w  w ork s h e e t: Us ing Ins e rt Sh e e t option) 

 Right click on the sheet tab and select Insert option from the shortcut menu.  

 

Fig. 5.44 (Ins e rt a Ne w  w ork s h e e t: Us ing Sh ortcut m e nu) 

Note: To change the order of the worksheets in a workbook, click the tab of the 

worksheet that you want to move, and then drag it to the location that you want. 

5.14.3 WORKING WITH MULTIPLE WORKSHEETS 

A workbook is a multi-page Excel document that contains multiple worksheets. 

Sometimes you need to work with the worksheets one at a time as if each is a single unit. 

Other times, the same information or formatting may need to be added to every worksheet. 

You can type and retype the same information in each worksheet and apply identical 

formatting, or you can group the worksheet and enter the information just once. 

Grouping worksheets allows you to apply identical formulas and/or formatting across all 

worksheets in a group. When you group worksheets, any changes made to one worksheet 

will be changed in any other worksheets in the group.  

For example, if several worksheets will have the same data, like- regions, departments, 



 5.28   Spreadsheets 

quarters, months, weeks, and days, then you type it once and it will appear on every 

worksheet included in the grouping. 

 

Fig. 5.45 (Multiple  w ork s h e e ts  in a Group) 

To Group Worksheets: 

 To select one worksheet, click the sheet tab. 

 To select more than one worksheet, hold the Control key down and click one or 

more worksheet tabs in the workbook. 

 To select all worksheets in a workbook, right-click any worksheet tab and choose 

Select All Sheets from the shortcut menu. 

 

Fig. 5.46 (Grouping W ork s h e e ts ) 
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When you are finished entering, moving, copying, or formatting data, you will need to 

ungroup worksheets. If you do not ungroup the sheets, any work you do in one sheet will 

be duplicated in all of the others. 

To Ungroup Worksheets: 

 Right-click any of the selected worksheet tabs. 

 Choose Ungroup Sheets from the shortcut menu. 

 

Fig. 5.47 (Ungrouping W ork s h e e ts ) 

5.14.4 DELETING A WORKSHEET 

Any worksheet can be deleted from a workbook, including those that have data in it.  

Note: Remember, a workbook must contain at least one worksheet. 

To Delete One or More Worksheets: 

 Select the worksheet or worksheets that you want to delete. 

Note: When multiple worksheets are selected, [Group] appears in the title bar at the top 

of the worksheet. To cancel a selection of multiple worksheets in a workbook, click any 

unselected worksheet. If no unselected sheet is visible, right-click the tab of a selected 

sheet, and then click Ungroup Sheets on the shortcut menu. 

 On the Home tab, in the Cells group, click the arrow next to Delete, and then click 

Delete Sheet. 
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Fig. 5.48 (De le ting a w ork s h e e t: Us ing De le te  Sh e e t Option) 

 You can also right-click the sheet tab of a worksheet or a sheet tab of any selected 

worksheets that you want to delete, and then click Delete Sheet. 

 

Fig. 5.49  (De le ting a w ork s h e e t: Us ing Sh ortcut m e nu) 

5.14.5 MOVING OR COPYING A WORKSHEET 

You can use the Move or Copy Sheet command to move or copy entire worksheets (also 

known as sheets), to other locations in the same or a different workbook. You can use the 

Cut and Copy commands to move or copy a portion of the data to other worksheets or 

workbooks. 

To Move or Copy Worksheets: 

 Select the worksheets that you want to move or copy. If you want to move or copy 

more than one, press and hold the Ctrl key, and then click the tabs of the sheets you 

want to copy. 

 Select Home Tab  Cells Group  Format   Move or Copy Sheet. 
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Fig. 5.50 (Moving or copying a w ork s h e e t) 

OR 

 You can also right-click a selected sheet tab, and then click Move or Copy. 

 
Fig. 5.51 (Moving or copying a w ork s h e e t: Us ing Sh ortcut m e nu) 

 Move or Copy dialog box will be appeared. In the Move or Copy dialog box, click 

the sheet that should be after the moved or copied sheet. 
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Fig. 5.52 (Move  or Copy Dialog box) 

 To copy the sheets instead of moving those, in the Move or Copy dialog box, select 

the Create a copy check box. 

 
Fig. 5.53 (Move  or Copy Dialog box: Cre ate  a Copy) 

 When you create a copy of the worksheet, the worksheet is duplicated in the 

workbook, and the sheet name indicates that it is a copy. For example, the first copy 

that you make of Sheet1 is named Sheet1 (2). 

 5.15  FORMULA 

Formulas are equations that perform calculations on data values in the worksheet. Like a 

calculator, Excel can execute formulas that add, subtract, multiply, and divide. A formula 

can be a combination of constant values, cell references and mathematical operators (+, -, /, *, =). 
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 A formula starts with an equal sign (=) in a cell. This tells Excel that you are entering 

a formula, not just numbers. 

 Type the equation you want to calculate. For example, to add up 10 and 20, you type 

=10+20. 

 Press the Enter key to complete your calculation.  

 Instead of entering numbers directly in your calculation formula, you can put them 

in separate cells, and then reference those cells in your formula, e.g., =A1+A2+A3. 

Example: 

The following formula multiplies 5 by 10 and then adds the value in cell A2 to the result: 

=A2+5*10 

Here,  

 5 and 10 are constant values. 

 + and * are mathematical operators. 

 A2 is the cell reference, which returns the value in cell A2.   

The formula is visible only in the Formula bar. A formula's result will change as different 

numbers are entered into the cells included in the formula's definition. 

Note: The cell address in a formula is known as the cell reference. 

 

Fig. 5.54 (Form ula Vis ible  in th e  Form ula bar) 

5.15.1 HANDLING OPERATORS IN FORMULA 

An operator in Excel specifies the type of calculation to be performed on a given set of 

values. Excel has a variety of operators, including arithmetic operators, comparison 

operators, and reference operators. 

(1) Arithmetic Operators 

Arithmetic operators are used to perform arithmetic operations over data values, like- 

addition, subtraction, multiplication, division etc. 

The following table shows how to handle basic arithmetic operators in Excel formula: 

Operator Description Excel Formula 

+ (Addition Operator) It makes the addition of two or more than two 

numeric values and gives a numeric value as a 

return. 

= A1 + B1 
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– (Subtraction Operator) Subtracts two or more than two numeric values 

and gives a numeric value in return 

= A1 – B1 

* (Multiplication 

Operator) 

Multiplies one numeric value with the other and 

gives a numeric value in return 

= A1 * B1 

/ (Division Operator) Divides the numerator (should be numeric) value 

with the denominator (should be numeric) value 

and gives a numeric value in return. 

= A1 / B2 

% (Percentage Operator) Converts the number present in a cell into a 

percentage (i.e., divides the number by 100) 

= A1 % 

^ (Exponential Operator) Raises the power of the first numeric value by the 

second numeric value. 

= A1 ^ B1 

(2) Logical / Comparison Operators 

These operators logically compare the two values (numeric or text) and return a Boolean 

output, i.e. TRUE or FALSE. 

The following table shows how to handle basic logical operators in Excel formula:  

Operator Description Excel Formula 

= (Equals To) It compares two values and returns TRUE if both 

values are equal; else returns FALSE. 

=A1 = B1 

<> (Not Equals To) It compares two values and returns TRUE if both 

values are not equal to each other else returns 

FALSE. 

=A1 <> B1 

> (Greater Than) It returns TRUE if the value in cell A1 (First Value) 

is greater than the value in cell B1 (Second Value) 

else returns FALSE. 

=A1 > B1 

< (Less Than) It returns TRUE if the value in cell A1 (First Value) 

is lesser than the value in cell B1 (Second Value); 

else returns FALSE. 

=A1 < B1 

>= (Greater than or equals 

to) 

It returns TRUE if the value in cell A1 (First Value) 

is greater than or equals to the value in cell B1 

(Second Value); else returns FALSE. 

=A1 >= B1 

<= (Less than or equals to) It returns TRUE if the value in cell A1 (First Value) 

is less than or equals to the value in cell B1 (Second 

Value); else returns FALSE. 

=A1 <= B1 
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(3) Reference Operators 

Reference operators are used to refer to the ranges from your excel spreadsheet in a 

formula. Following are the reference operators used in Excel: 

Operator Description Excel Formula 

: (Colon) It is a range operator that gives a range of cells within 

start point and end point reference cells. 

= SUM(A2:B6) 

The above formula 

provides sum of all cell 

values as a range 

starting from A2 to cell 

B6. 

, (Comma) It is a union operator. This operator combines (as the 

word union suggests) two or more than two 

references into a single reference. 

= SUM(A2:A6, A2:B3) 

 (space) It is an intersection operator. This operator only gives 

reference to those cells which are common in two 

range arguments. 

= SUM(A2:A6 A2:B3) 

5.15.2 COPY AND PASTE FORMULA 

The process to copy and paste a formula is identical to that process used to copy and 

paste text. 

To Copy and Paste a Formula: 

 Select the cell that contains the formula to be copied.  

 

Fig. 5.55 (Copy a Form ula) 

 To copy the formula, click on the Home tab  Clipboard group  Copy command. 

 

Fig. 5.56 (Copy Com m and) 
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     OR 

Press Ctrl+C. 

 Now, select the cell where the copied formula is to be pasted.  

 To paste the formula, click on the Home tab  Clipboard group  Paste command. 

 
Fig. 5.57 (Pas te  Com m and) 

OR 

 Press Ctrl+V. 

OR 

 Press the Enter key. The formula is copied to the new location.  

 
Fig. 5.58 (Pas te  a Form ula) 

Note: The cell references in a formula are automatically updated when the formula is 

copied to another cell in the worksheet. 

5.15.3 REVISING FORMULA 

You can revise any formula that was previously written in a worksheet. 

To Revise a Formula: 

 Double-click the cell that contains the formula you want to revise.  

 The cursor can now move left and right between the values in the formula. 

 

 Make the necessary changes to the formula. Like, replace cell A2 with cell A3 in the 

formula. 
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 Press the Enter key to accept the new formula. 

 

 5.16  CELL REFERENCING 

The cell address in a formula is known as the cell reference. With the help of cell 

references, you can use the data in different parts of a worksheet.  

Types of Cell Referencing: 

There are three types of cell references: 

(1) Relative Reference: When you create a formula, references to cell(s) are usually 

based on the position relative to the cell. When you copy or move a formula to other cells, 

the reference cell automatically changes. 

Example: 

In Figure 5.59, the formula in A3 is = A1+A2. When you copy the formula from A3 to B3, 

Excel automatically changes the reference to match the location of cells i.e. it becomes 

B3=B1+B2. 

 
Fig. 5.59  (Re lative  Re fe re nce : Sim ple  form ula) 

 
Fig. 5.60 (Re lative  Re fe re nce : Copy and Pas te  th e  form ula) 
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(2) Absolute Reference: Absolute reference is used when you do not want to change the 

address of the cell on copying the formula to another cell. For this purpose, you have to add 

the dollar symbol ($) before the column and the row number. 

Example: 

 Enter the numbers (Figure 5.61) you want to calculate (e.g., 34,567.00 in cell B2 and 

1,234.00 in cell B3). 

 Then, create a simple formula (=B2+B3) in cell B5. 

 

Fig. 5.61 (Abs olute  Re fe re nce : Sim ple  form ula) 

 To create an absolute reference in the formula just created, insert a $ symbol before 

the B (column reference) and 2 (row reference) in the reference to B2 so the new 

formula reads, (=$B$2+B3). (Fig. 5.62) 

 

Fig. 5.62 (Abs olute  Re fe re nce : Cre ate  an abs olute  re fe re nce ) 

 Copy and Paste the formula to another adjacent cell (D5). The formula now includes 

an absolute reference to B2, (=$B$2+D3). 
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Fig. 5.63 (Abs olute  Re fe re nce : Obs e rve  th e  Ce ll Re fe re nce  once  th e  form ula is  applie d) 

(3) Mixed Reference:  It is a combination of Relative and Absolute reference. In this type 

of reference, either row or column has to remain fixed. 

Example: 

 Enter the numbers you want to calculate.  

(e.g., 10 in cell A1 and 20 in cell A2). (Fig. 5.64) 

 Then, create a simple formula (=A1+A2) in cell A3. 

 

Fig. 5.64 (Mixe d Re fe re nce : Sim ple  form ula) 

 To create a mixed reference in the formula just created, insert a $ symbol before the 

A (column reference) for A1 and a $ symbol before the 2 (row reference) for A2 in 

the formula bar. The new formula reads, (=$A1+A$2). (Fig. 5.65) 

 

Fig. 5.65 (Mixe d Re fe re nce : Cre ate  a m ixe d re fe re nce ) 

 Copy and Paste the formula to another adjacent cell (B3). The formula now includes 

a mixed reference for the cell B3 (=$A1+B$2). 
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Fig. 5.66 (Mixe d Re fe re nce : Obs e rve  th e  Ce ll Re fe re nce  Once  th e  form ula is  applie d) 

 5.17  FUNCTIONS 

Functions are predefined formulas that perform calculations by using specific values, 

called arguments, in a particular order. Functions can be used to perform simple or complex 

calculations. Functions save you the time of writing lengthy formulas.  

For example, you can use an Excel function called Average, to quickly find the average of 

range of numbers. 

  Each function has a specific order, called syntax, which must be strictly followed for the 

function to work correctly. 

Syntax Order: 

1. All functions begin with the = sign.  

2. After the = sign, define the function name (e.g., SUM).  

3. After the function name, define argument(s) enclosed by parentheses (numbers, text 

or cell references). If there is more than one argument, separate each by a comma.  

An example of a function with one argument that adds a range of cells, B3 through B10: 

 

Fig. 5.67 (Function w ith  One  Argum e nt) 

An example of a function with more than one argument that calculates the average of 

numbers in a range of cells, B3 through B10, and C3 through C10: 

 

Fig. 5.68 (Function w ith  m ore  th an One  Argum e nt) 
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Excel provides hundreds of functions to assist you in different sort of calculation. Some 

of the commonly used functions are discussed below: 

5.17.1 MATHEMATICAL FUNCTIONS 

Excel's Mathematical functions can be used to perform common mathematical 

operations such as addition, multiplication and rounding numbers. Some of the commonly 

used mathematical functions are discussed below: 

(1) SUM 

The SUM function returns the sum of values supplied. These values can be numbers, cell 

references, ranges, and constants, in any combination. 

Example: 

In the following spreadsheet, the SUM function is used to calculate the sum of the 

numbers 5, 6, 7, 8 & 9. In each of the five methods, the numbers are supplied to the SUM 

function in a different way. 

 

(2) SUMIF 

The SUMIF function returns the sum of cells that meet a single condition. Criteria can be 

applied to dates, numbers, and text. 

Example: 

The following spreadsheet shows three examples of the SUMIF function used with text-

based criteria: 



 5.42   Spreadsheets 

 

(3) PRODUCT 

The PRODUCT function returns the product of a supplied set of numerical values. 

Example: 

In the following spreadsheet, the PRODUCT function is used to calculate the product of 

the numbers 3, 6, 2, 8 & 5. In each of the five methods, the numbers are supplied to the 

PRODUCT function in a different way. 

 

(4) SUMPRODUCT 

The SUMPRODUCT function returns the sum of the products of the corresponding 

values in a set of supplied arrays. 
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Example:  

The following spreadsheet shows the use of SUMPRODUCT function: 

 

(5) POWER 

The POWER function calculates a given number, raised to a supplied power. 

Example:  

The following spreadsheet shows the use of POWER function: 

 

(6) SQRT 

The SQRT function calculates the positive square root of a supplied number. If the 

supplied number is negative, the SQRT function returns the #NUM! Error. 

Example: 

The following spreadsheet shows the use of SQRT function: 
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(7) SUBTOTAL 

The SUBTOTAL function performs a specified calculation (Eg.  the sum, product, 

average, etc.) for a supplied set of values. 

Syntax of the function is: 

SUBTOTAL( function_num, ref1, [ref2], ... ) 

     Here,  

function_num - An integer that denotes the calculation type (e.g. sum, average, etc.). 

ref1, [ref2], ... - One or more references to cells containing the values that the calculation 

is to be performed on. Blank cells and cells containing non-numeric values 

are ignored in the calculation. 

The following table (Table 5.1) shows the possible values for function_num: 

Table 5.1 

function_num 

(include hidden values) 

function_num 

(ignore hidden values) 
Function 

1 101 AVERAGE 

2 102 COUNT 

3 103 COUNTA 

4 104 MAX 

5 105 MIN 

6 106 PRODUCT 

7 107 STDEV 

8 108 STDEVP 

9 109 SUM 

10 110 VAR 

11 111 VARP 

Example: 

The following spreadsheet shows the use of SUBTOTAL function: 
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 In the example above, as all cells are visible, we could have set the  function_num  

argument to be either 9 or 109 for the SUM, and to be either 1 or 101 for the AVERAGE 

calculation (Refer Table 5.1). Both options would give the same results. 

(8) MOD 

The MOD function returns the remainder of a division between two supplied numbers. 

Example: 

The following spreadsheet shows the use of MOD function: 

 

(9) ROUND 

The ROUND function rounds a supplied number up or down, to a specified number of 

decimal places. 

Example: 

The following spreadsheet shows the use of ROUND function: 

 

(10) LOG10 

The LOG10 function calculates the base-10 logarithm of a number. The base-10 

logarithm of a number is the power to which 10 must be raised to obtain that number. For 

example, the base-10 logarithm of 100 is 2, because 10 raised to the power of 2 is 100. 

Example: 

The following spreadsheet shows the use of LOG10 function: 
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(11) ABS 

The ABS function returns the absolute value of a number. In other words, it is the 

positive version of the number, regardless of whether the number is positive or negative. 

Example: 

The following spreadsheet shows the use of ABS function: 

 

(12) LN 

The LN function calculates the natural logarithm of a number. The natural logarithm 

uses the mathematical constant e (approximately 2.71828) as the base. In simpler terms, it 

tells you to which power e must be raised to get a certain number. 

Example: 

The following spreadsheet shows the use of LN function: 

 

5.17.2 STATISTICAL FUNCTIONS 

Excel provides a wide range of statistical functions that perform calculations, from 

computing basic mean (average) to the more complex analytical tests. Some of the 

commonly used statistical functions are discussed below: 

(1) AVERAGE 

The AVERAGE function is used to calculate the average or the arithmetic mean of a list 

of supplied numbers. 
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Example: 

In the following spreadsheet, the AVERAGE function is used to calculate the arithmetic 

mean of the numbers 8, 7, 9, 6 & 10. In each case, the values are supplied to the function in 

different ways. 

 

(2) MIN 

The MIN function returns the smallest value from a supplied set of numeric values. 

Example: 

The following spreadsheet shows the use of MIN function: 

 

(3) MAX 

The MAX function returns the largest value from a supplied set of numeric values. 

Example: 

The following spreadsheet shows the use of MAX function: 
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(4) COUNT 

The COUNT function returns the count of numeric values in a supplied set of cells or 

values. This count includes both numbers and dates. 

Example: 

The following spreadsheet shows the use of COUNT function: 

 

(5) COUNTIF 

The COUNTIF function returns the number of cells within a supplied range, that satisfy 

a given criteria or condition. 

Example: 

 

Based on the above spreadsheet, the following COUNTIF functions will return the 

different results: 
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(6) MEDIAN 

The MEDIAN function in Excel is a statistical function that calculates the middle value 

of a set of numbers. When the data set has an odd number of values, the median is the 

middle value. When the data set has an even number of values, the median is the average of 

the two middle values. 

Example: 

 

(7) MODE 

The MODE function in Excel is a statistical function that calculates the most frequently 

occurring value in a data set. It returns the value or values that appear the most often within 

a range of cells. The MODE function is useful for identifying patterns and trends in data. 

Example: 
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(8) STDDEV 

The STDEV function in Excel calculates the standard deviation of a sample of data. The 

standard deviation is a measure of how spread out the data is from the average value. A low 

standard deviation indicates that the data is clustered closely around the mean, while a high 

standard deviation indicates that the data is spread out over a wider range of values. 

Example: 

 

(9) VAR 

The VAR function in Excel calculates the variance of a sample of data. Variance is a 

statistical measure that indicates how much a set of numbers varies from its mean (average). 

A higher variance indicates that the numbers are more spread out, while a lower variance 

indicates that the numbers are more tightly clustered around the mean. 

Example: 

Suppose you have a set of exam scores: 80, 75, 90, 85, and 95. To calculate the variance of 

these scores, you would use the following formula: 

=VAR(80, 75, 90, 85, 95) 

This formula would return a value of 62.5, which is the variance of the exam scores. 

(10) SKEW 

The SKEW function calculates the skewness of a dataset, indicating whether the data is 

skewed to the left (negative skewness), to the right (positive skewness), or is symmetrical 

(zero skewness). 
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Example: 

Let's consider a simple dataset: 5, 8, 8, 10, 12. To calculate the skewness of the dataset, 

you would use the following formula: 

=SKEW(5, 8, 8, 10, 12) 

This formula would return a value of -0.1184, indicating negative skewness. 

(11) KURT 

The KURT function calculates the kurtosis of a dataset, which is a measure of the 

sharpness of a distribution's peak. It helps you understand whether the data is more or less 

peaked than a normal distribution. 

Example: 

Suppose you have a dataset of exam scores: 75, 80, 85, 90, and 95. To calculate the 

kurtosis of these scores, you would use the KURT function in Excel like this: 

=KURT(75, 80, 85, 90, 95) 

This formula would return a value of -1.2. 

(12) CORREL 

The CORREL function measures how much two sets of numbers are related to each 

other. It gives you a number between -1 and 1, where: 

 1: Perfect positive correlation (as one set of numbers increases, the other set also 

increases). 

 0: No correlation (there's no apparent relationship between the sets of numbers). 

 -1: Perfect negative correlation (as one set of numbers increases, the other set 

decreases). 

Example: 
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5.17.3 LOGICAL FUNCTIONS 

In Excel, Logical functions are used frequently for testing conditions and making 

decisions. Some of the commonly used logical functions are discussed below: 

(1) IF 

The IF function checks whether a condition is met or not. It returns one value if the 

condition is TRUE and another value if the condition is FALSE. 

Example: 

In the following spreadsheet, select cell C1, enter the function =IF(A1>=33, 

"PASS","FAIL") and Press Enter. 

 

Here, the IF function returns PASS in cell C1 because the value in cell A1 is equals to 33. 

(2) AND 

The AND function returns TRUE if all conditions are true and returns FALSE if any of 

the conditions are false. 

Example: 

In the following spreadsheet, select cell C1, enter the function =IF(AND(A1>=60,B1<100), 

"FIRST","SECOND") and Press Enter. 

 

Here, the AND function returns FALSE because the value in cell A1 is not greater than 

or equals to 60, though the value in cell B1 is less than 100. So in this function, the second 

condition is true, but the first condition is false. As a result, this function returns FALSE and 

put SECOND in cell C1. 

(3) OR 

The OR function returns TRUE if any of the conditions are TRUE and returns FALSE if 

all conditions are false. 

Example: 

In the following spreadsheet, select cell C1, enter the function =IF(OR(A1>=60,B1<100), 

"FIRST","SECOND") and Press Enter. 



 Spreadsheets  5.53   

 

Here, the OR function returns TRUE because the value in cell B1 is less than 100, though 

the value in cell A1 is not greater than or equals to 60. So in this function, out of two 

conditions, one is true.  As a result, this function returns TRUE and put FIRST in cell C1. 

(4) NOT 

The NOT function returns the opposite to a supplied logical value. That is, if the 

supplied value is TRUE, the NOT function returns FALSE and if the supplied value is 

FALSE, the NOT function returns TRUE. 

Example: 

The following spreadsheet shows the use of NOT function: 

 

5.17.4 DATE AND TIME FUNCTIONS 

Excel provides a number of functions to work with dates and times. Some of the 

commonly used date and time functions are discussed below: 

(1) DATE 

The DATE function converts a supplied year, month and day into an Excel date. 

Example: 
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(2) TIME 

The TIME function accepts three integer arguments representing hours, minutes and 

seconds, and returns an Excel time i.e. it returns the decimal value that represents the time 

in Excel. 

Example: 

 

(3) NOW 

The NOW function returns the current date and time. This function receives no 

arguments. The NOW function updates every time your Excel worksheet is refreshed, and 

so any cell(s) containing this function will be continually changing. 

Example: 

 

(4) TODAY 

The TODAY function returns the current date. The function has no arguments. 

Example: 

 

(5) DAY 

The DAY function returns an integer representing the day of the month (from 1 - 31) of a 

supplied date. 

Example: 
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(6) MONTH 

The MONTH function returns an integer, representing the month (from 1 - 12) of a 

supplied date. 

Example: 

 

(7) YEAR 

The YEAR function returns an integer representing the year of a supplied date. 

Example: 

 

(8) HOUR 

The HOUR function returns an integer representing the hour component of a supplied 

time. 

Example: 
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(9) MINUTE 

The MINUTE function returns an integer representing the minute component of a 

supplied time. 

Example: 

 

(10) SECOND 

The SECOND function returns an integer representing the second component of a 

supplied time. 

Example: 

 

5.17.5 TEXT FUNCTIONS 

Excel has many functions to offer when it comes to manipulating text or strings. Some of 

the commonly used text functions are discussed below: 

(1) LEFT 

The LEFT function is used to extract the leftmost characters from a string. It returns a 

specified number of characters from the start of a supplied text string. 

Example: 

The following spreadsheet shows the use of LEFT function: 
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(2) RIGHT 

The RIGHT function is used to extract the rightmost characters from a string. It returns a 

specified number of characters from the end of a supplied text string. 

Example: 

The following spreadsheet shows the use of RIGHT function: 

 

(3) MID 

The MID function is used to extract a substring, starting in the middle of a string. It 

returns a specified number of characters from the middle of a supplied text string. 

Example: 

The following spreadsheet shows the use of MID function: 

 

(4) LEN 

The LEN function is used to get the length of a string. It returns the length of a supplied 

text string. 

Example: 

The following spreadsheet shows the use of LEN function: 
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(5) FIND 

The FIND function is used to find the position of a substring in a string. It returns the 

position of a specified character or sub-string within a supplied text string. 

Example: 

The following spreadsheet shows the use of FIND function: 

 

(6) LOWER 

The LOWER function converts all characters in a supplied text string to lower case. 

Example: 

The following spreadsheet shows the use of LOWER function: 

 

(7) UPPER 

The UPPER function converts all characters in a supplied text string to upper case. 
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Example: 

The following spreadsheet shows the use of UPPER function: 

 

(8) TRIM 

The TRIM function removes extra spaces (i.e. all spaces except for single spaces between 

words or characters) from a supplied text string. 

Example: 

The following spreadsheet shows the TRIM function applied to four different text 

strings: 

 

In all four of the above cases, the result is the string "trimmed text". 

- with no spaces at the start or end and just one space in the middle. 

5.17.6 ERROR FUNCTIONS 

Error functions in Excel are a set of functions designed to handle and manage errors in 

formulas. These functions allow you to identify, trap, and handle errors in your 

spreadsheets, preventing them from causing unexpected results or crashes. 

(1) ISERROR Function: The ISERROR function checks whether a formula evaluates to an 

error or not. It returns TRUE if the formula evaluates to an error and FALSE otherwise. 

Syntax: 

ISERROR(value) 

Here, 

 value: The formula or expression to be checked for errors. 
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Example: 

=ISERROR(10/0) 

This formula attempts to divide 10 by 0. Since division by 0 is an invalid operation, the 

formula will evaluate to an error. The ISERROR function will return TRUE in this case, 

indicating that an error occurred. 

(2) NA Function: The NA function in Excel is used to represent a missing or unavailable 

value in a spreadsheet. It is an error value that is used to indicate that a cell does not contain 

any data. 

To use the NA function, simply type =NA() into a cell. The cell will then display the 

error value #N/A. 

Syntax: 

NA() 

Example: 

Let's say you have a spreadsheet that tracks sales figures for each month of the year. For 

the month of January, you do not have any sales data. You can use the NA function to 

indicate that the sales data for January is missing: 

 

By using the NA function, you can avoid errors in your formulas. For example, if you 

calculate the average sales for the year, the formula =AVERAGE(B2:B6) will not include the 

missing sales data for January. 

(3) IFERROR Function: The IFERROR function is a versatile error-handling function in 

Excel that allows you to specify an alternative value to return if a formula evaluates to an 

error. This function is crucial for preventing errors from causing unexpected results or 

crashes in your spreadsheets. 

Syntax: 

IFERROR(value, value_if_error) 



 Spreadsheets  5.61   

Here, 

 value: The formula or expression to evaluate. 

 value_if_error: The value to return if the formula evaluates to an error. This value 

can be a text message, a numeric value, another formula, or even an empty cell. 

Example: 

Let's say you have a formula =AVERAGE(A2:A10) that calculates the average of a range 

of cells, but one of the cells in the range contains invalid data. 

To prevent the formula from displaying an error message and instead return a more 

informative message, you can use the IFERROR function as follows: 

=IFERROR(AVERAGE(A2:A10), "Invalid data found") 

In this example, if the AVERAGE formula evaluates to an error due to invalid data, the 

IFERROR function will return the text message "Invalid data found" instead of displaying 

an error message. 

5.17.7 LOOKUP AND REFERENCE FUNCTIONS 

The lookup and reference functions help you to work with arrays of data, and are 

particularly useful when you need to cross reference between different data sets. Some of 

the commonly used lookup and reference functions are discussed below: 

(1) HLOOKUP 

The HLOOKUP function looks up a supplied value in the first row of a table, and 

returns the corresponding value from another row. 

Syntax: 

HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup]) 

Here, 

 lookup_value: The value that you want to search for, in the first row of the supplied 

data array (table). 

 table_array: The data array or table, containing the data to be searched in the top 

row, and the return values in any other row. 

 row_index_num: The row number, within the supplied table_array, that you want 

the corresponding value to be returned from. 

 [range_lookup]: An optional logical argument, which can be set to TRUE or FALSE, 

means: 
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(i) TRUE- if the function cannot find an exact match to the supplied lookup_value, 

it should use the closest match below the supplied value. 

(ii) FALSE- if the function cannot find an exact match to the supplied lookup_value, 

it should return an error. 

 Example: 

 

In the above example, the HLOOKUP function searches through the top row of the 

table_array (the range A2-F2), to find a match for the lookup_value (the name "Ed"). When 

the name "Ed" is found, the function returns the corresponding value from the 5th row of 

the table_array. 

 

(2) VLOOKUP 

The VOOKUP function looks up a supplied value in the first column of a table, and 

returns the corresponding value from another column. 

Syntax: 

VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

Here- 

 lookup_value: The value that you want to look up. 

 table_array: The data array or table, containing the search values in the left hand 

columns and the return values in another column. 
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 col_index_num: The column number, within the supplied table_array, that you want 

to return a value from. 

 [range_lookup]: An optional logical argument that describes what the function 

should return in the event that it does not find an exact match to the lookup_value. 

The [range_lookup] can be set to TRUE or FALSE, means: 

(i) TRUE- If the function cannot find an exact match to the supplied lookup_value; 

it should use the closest match below the supplied value. 

(ii) FALSE- If the function cannot find an exact match to the supplied lookup_value, 

it should return an error. 

Example: 

 

The above VLOOKUP function returns the price for "Cornflakes", which is $3.50. 

In this example: 

 The lookup_value is the text string "Cornflakes", which is located in cell D2; 

 The table_array is columns A-B of the spreadsheet; 

 The col_index_num is set to 2, to denote that the value returned should be taken 

from column 2 of the table_array; 

The [range_lookup] argument is set to FALSE, to indicate that we only want a result to 

be returned if an exact match to the lookup_value is found. 

5.17.8 FINANCIAL FUNCTIONS 

Excel provides a wide range of financial functions that are useful for financial analysis, 
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calculations, and modeling. Here are some important financial functions in Excel with 

suitable examples:  

(1) PMT (Payment) 

The PMT function calculates the periodic payment for a loan or investment based on a 

constant interest rate, a fixed number of periods, and a present value. 

Example: Suppose you want to calculate the monthly payment for a 5,00,000 loan with 

an annual interest rate of 8% for a term of 5 years. The formula would be: 

=PMT(8%/12, 5*12, -500000) 

The result would give you the monthly payment amount. In the above example, the 

result would be `10,138.20. 

(2) PV (Present Value) 

The PV function calculates the present value of an investment.  

Example: Let's say you are considering an investment that will pay you `1,000 per year 

for the next 5 years, with an interest rate of 8%. The formula would be: 

=PV(8%, 5, -1000) 

The result would give you the present value of the investment. In the above example, 

the result would be `3,992.71. 

(3) FV (Future Value) 

The FV function calculates the future value of an investment based on a constant interest 

rate, a fixed number of periods, and regular periodic payments. 

Example: Let's say you invest �1,000 per month into an account with an annual interest 

rate of 7% for a period of 10 years. You can use the FV function to calculate the future value 

of the investment. The formula would be: 

=FV(7%/12, 10*12, -1000) 

The result would give you the total value of the investment at the end of the 10-year 

period. In the above example, the result would be � 1,73,084.81. 

(4) RATE 

The RATE function calculates the interest rate per period for an investment or loan 

based on regular periodic payments. 

Example: Let's say you are considering a loan with a monthly payment of ` 10,174 for a 
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period of 5 years and a present value of ` 5,00,000. You can use the RATE function to 

calculate the interest rate. The formula would be: 

=RATE(5*12, -10174, 500000) 

This formula would return the interest rate per month, which is 0.68%. To calculate the 

annual interest rate, you would multiply the monthly interest rate by 12. Then, the formula 

would be: 

=RATE(5*12, -10174, 500000) * 12 

The final result would be 8.15%. 

(5) NPER 

The NPER function is used to calculate the number of periods required to pay off a loan 

or investment based on fixed, periodic payments and a constant interest rate. It stands for 

"Number of Periods." 

Example: Suppose you take out a loan of $10,000 at an annual interest rate of 5%, and 

you plan to make monthly payments of $200. You want to know how many months it will 

take to pay off the loan. 

The formula would be: 

=NPER(5%/12, -200, 10000) 

Here, 

 rate: 5% annual interest rate, so 5%/12 for monthly rate. 

 payment: Monthly payment is -200 (negative because it's an outgoing payment). 

 present_value: Loan amount is 10,000. 

The result would be 56.1843 number of periods (months) required to pay off the loan. 

(6) NPV 

The NPV function is used to calculate the net present value of an investment based on a 

series of future cash flows, discounted at a specified rate. NPV stands for Net Present Value. 

Example: Suppose you are considering an investment that costs $1,000 today (Year 0), 

and it generates cash flows of $500 at the end of Year 1 and $700 at the end of Year 2. You 

want to calculate the NPV of this investment with a discount rate of 5%. 

The formula would be: 

=NPV(5%, -1000, 500, 700) 
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Here, 

 Rate (Discount Rate): 5% 

 Cash Flows: 

 Year 0: -$1,000 (initial investment, negative because it's an outflow) 

 Year 1: $500 (inflow) 

 Year 2: $700 (inflow) 

The NPV (Net Present Value) would be $105.82. 

5.17.9 DATABASE FUNCTIONS 

Excel has a number of database functions that you can use to find specific information 

from the database based on set criteria. 

The database functions perform basic operations, such as sum, average, count, etc., but 

they also have criteria arguments, that allow you to only perform the calculation for a 

specified subset of the records in your database. 

(1) DSUM Function 

The DSUM function calculates the sum of values in a field of a list or database that 

satisfies specified conditions. 

Example: 

(i) Create a new worksheet and enter the database list, as shown below: 
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(ii) Click the cell E10. 

(This is where you want to place the total sales value for sales person “Puneet”.) 

(iii) Click on Formulas Tab  Function Library Group  Insert Function Command. 

Insert Function dialog box appears. 

(iv) In the select a category box, click the drop-down arrow and click Database from 

the list. In the Select a function box, scroll down and click DSUM function.  

 

(v) Click OK button. 

(vi) Function Arguments dialog box appears. 

 In the Database box, select the range A1:E8. 

 In the Field box, select the cell E1. 

 In the Criteria box, select the range G4:G5. 



 5.68   Spreadsheets 

The arguments for the function are shown below: 

 

(vii) Click the OK button. The result is shown on the worksheet. 

 

(2) DAVERAGE Function 

The DAVERAGE function calculates the average of values in a field of a list or database 

that satisfies specified conditions. 
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Example: 

(i) Create a new worksheet and enter the database list, as shown below: 

 

(ii) Click the cell E11. 

(This is where you want to place the average sales value for sales person “Puneet”.) 

(iii) Click on Formulas Tab  Function Library Group  Insert Function Command. 

Insert Function dialog box appears. 

(iv) In the select a category box, click the drop-down arrow and click Database from 

the list. In the Select a function box, scroll down and click DAVERAGE function. 
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(v) Click OK button. 

(vi) Function Arguments dialog box appears. 

 In the Database box, select the range A1:E8. 

 In the Field box, select the cell E1. 

 In the Criteria box, select the range G4:G5. 

The arguments for the function are shown below: 

 

(vii) Click the OK button. The result is shown on the worksheet. 

 

(3) DMAX Function 

The DMAX function returns the maximum value from a field of a list or database that 

satisfies specified conditions. 



 Spreadsheets  5.71   

Example: 

(i) Create a new worksheet and enter the database list, as shown below: 

 

(ii) Click the cell E12. 

(This is where you want to place the highest sales value for sales person “Puneet” 

in February.) 

(iii) Click on Formulas Tab  Function Library Group  Insert Function Command. 

Insert Function dialog box appears. 

(iv) In the select a category box, click the drop-down arrow and click Database from 

the list. In the Select a function box, scroll down and click DMAX function. 
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(v) Click OK button. 

(vi) Function Arguments dialog box appears. 

 In the Database box, select the range A1:E8. 

 In the Field box, select the cell E1. 

 In the Criteria box, select the range G4:H5. 

The arguments for the function are shown below: 

 

(vii) Click the OK button. The result is shown on the worksheet. 

 

(4) DCOUNTA Function 

The DCOUNTA function returns the number of non-blank cells in a field of a list or 

database that satisfies specified conditions. 



 Spreadsheets  5.73   

Example: 

(i) Create a new worksheet and enter the database list, as shown below: 

 

(ii) Click the cell E13. 

(This is where you want to count the occurrences of records for sales person 

“Puneet” in February.) 

(iii) Click on Formulas Tab  Function Library Group  Insert Function Command. 

Insert Function dialog box appears. 

(iv) In the select a category box, click the drop-down arrow and click Database from 

the list. In the Select a function box, scroll down and click DCOUNTA function. 
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(v) Click OK button. 

(vi) Function Arguments dialog box appears. 

 In the Database box, select the range A1:E8. 

 In the Field box, select the cell A1. 

 (You can use any field in the database because the function is counting the 

occurrences, not the value in the field.) 

 In the Criteria box, select the range G4:H5. 

The arguments for the function are shown below: 

 

(vii) Click the OK button. The result is shown on the worksheet. 
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 5.18  AUTOSUM FUNCTION 

 The AutoSum function provides a shortcut to adding up columns or rows of numbers in 

an Excel spreadsheet. It is used to sum the values of columns or rows with a single click. 

How to use AutoSum? 

 Type the numbers to be included in the formula in separate cells of a column in 

worksheet. 

 

 Highlight the range of numbers to be added, from cell B2 to cell B6. 

 

 Click the Home tab  Editing group  AutoSum command. 

 

Fig. 5.69  (AutoSum  Com m and) 

 The sum of the numbers will be added to cell B7, or the cell immediately beneath the 

defined range of numbers.  
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 Notice the formula, =SUM(B2:B6), has been defined to cell B7. 

 

 5.19  SPEEDING UP DATA ENTRY 

Excel provides some speedy tools to enter data in a faster and smarter way than via the 

keyboard. 

5.19.1 FILL TOOL 

 Fill tool is a way to duplicate existing content. It basically helps you fill in sequential 

data without having to type in every cell. 

To Use Fill Tool: 

 Start by selecting the cell to copy. You will notice a small square- called a Fill handle- 

in the bottom right-hand corner of the cell. 

 

Fig. 5.70 (Fill H andle ) 

 Hold your mouse pointer over the fill handle, it will change to a plus sign (+). 

 

 Click on the + sign and drag the mouse in any direction (Down, Up, Right or Left). 
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Fig. 5.71 (Us e  of Fill H andle ) 

OR 

 Hold down the Shift key and click in the last cell you want to fill. Thereafter, click on 

Home tab  Editing group  Fill command. A drop-down list will be appeared. 

Select the direction (say- down) in which you want to copy. 

 

Fig. 5.72 (Fill Com m and) 

 The result would be look like: 

 

Note: If the cell contains a number, the number will fill in series. If the cell contains text, 

the same text will fill in the direction you choose. 

5.19.2 FILL SERIES 

A more complex use of the Fill Tool is to use a Fill Series. The default lists are for the full 

and abbreviated days of the week and the months of the year, but you can create your own 

lists as well. 
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To Add a Fill Series to a Spreadsheet: 

 Type the starting value for the series and then select the cells to fill. 

 

 Click on Home tab  Editing group  Fill command. A drop-down list will be 

appeared. Select the Series option from the list. 

 

Fig. 5.73 (Fill Se rie s ) 

 Series dialog box will be displayed. 

 

Fig. 5.74 (Se rie s  Dialog box) 
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 In the Series dialog box, select AutoFill as the Series type. 

 Click OK. 

 

Fig. 5.75 (Se rie s  Dialog box: AutoFill Type ) 

 The selected cells then fill in the other items on the list sequentially, repeating from 

the top of the list when they reach the end of the list. 

 

Fig. 5.76 (Fill Se rie s  Re s ult) 

 5.20  CONDITIONAL FORMATTING 

A format, such as cell shading or font color, that Excel automatically applies to cells if a 

specified condition is true. 

Conditional formatting is a special formatting feature of Excel that sets a cell's format 

according to conditions that you specify. 

Conditional formatting allows you to present numeric data in different colors; For 

example, you can shade data depending on whether the value is greater, equal to, or less 

than zero. 

Example: 

To apply different shades to the rows / cells of a worksheet, follow these steps: 

 Start Excel, and then open New Worksheet. 
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 Type the following data in cells A1:D5: 

 

 Select the range D2:D5. 

 

 In Home tab, under Styles group, click Conditional Formatting command. A drop 

down list will be displayed. Click Highlight Cells Rules  Greater Than. 

 

Fig. 5.77 (Conditional Form atting Com m and) 

 Greater Than dialog box will be appeared. 

 
Fig. 5.78 (Gre ate r Th an Dialog box) 
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 Enter value 70 in the GREATER THAN field and select “Light Red Fill” option 

from the “with: drop down list”.  

 

 Click OK. 

 The final result of conditional formatting would be look like: 

 

 5.21  PRINTING WORKSHEETS 

Printing in Excel is much like printing in other Office applications like Microsoft Word. By 

default, Excel prints the entire worksheet.  

Print Preview is a method to review the formatting and make sure the columns, rows, 

and margins appear exactly as you want them. 

In Excel 2010, you can print and preview files from the same location by clicking File 

and then Print (or pressing CTRL+P). 

Excel allows you to print all or part of a worksheet or workbook, with just the 

information you need. 

To View the Print pane: 

 Click the File tab. This takes you to Backstage view. 

 Select Print. The Print pane appears, with the print settings on the left and Print 

Preview on the right. 
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Fig. 5.79  (Print Pane  W indow ) 

5.21.1 USING PRINT RANGES 

By default, Excel prints the whole worksheet. Sometimes, you only need to print some 

specific ranges instead of the whole worksheet for saving paper and printer ink.  

This section will talk about how to print multiple cell ranges in Microsoft Excel. 

To Print a Worksheet:  

 Select the worksheets that you want to print.  

 To print multiple worksheets, click the first worksheet, hold down the Ctrl key, then 

click the other worksheets you want to select. 

 Click File, and then click Print. 

OR 

Press Ctrl+P. The Print pane window appears. 

 Click the Print button. 

To Print Active sheet: 

 A worksheet is considered active if it is selected. 

 Select the worksheets you want to print. 

 Click the File tab  Print to access the Print pane. 
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 Select Print Active Sheets from the print range drop-down menu. 

 

Fig. 5.80 (Print Active  Sh e e ts ) 

 Click the Print button. 

To Print the Entire Workbook: 

 Click the File tab  Print to access the Print pane. 

 Select Print Entire Workbook from the print range drop-down menu. 

 

Fig. 5.81 (Print Entire  W ork book ) 

 Click the Print button. 

To Print a Selection: 

 Select the cells you want to print. 

 Click the File tab  Print to access the Print pane. 

 Select Print Selection from the print range drop-down menu. 

 

Fig. 5.82 (Print Se le ction) 
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 You can see what your selection will look like on the page in Print Preview. 

 Click the Print button. 

To Print only Selected Cell Ranges: 

 Hold down the Ctrl key to select the non-contiguous ranges or cells. 

 Click Page Layout tab  Page Setup group  Print Area command. From the drop 

down list, select Set Print Area. 

 

Fig. 5.83 (Print Se le cte d Ce ll Range s ) 

 The selected ranges will be surrounded by a dotted line. Click File  Print to start 

printing the ranges one by one. 

Note: This Set Print Area command only allows you to select and print cell ranges in the 

active worksheet. If you switch to another worksheet, the previous set print areas will be 

cleared. 

5.21.2 PAGE ORIENTATION 

Page orientation controls the way in which information is printed on the page. You can 

print a worksheet in landscape or portrait orientation. Portrait is useful for worksheets 

needing to fit more rows on one page, while landscape is useful for worksheets needing to fit 

more columns on one page. 

To Change Page Orientation: 

 Click the File tab  Print to access the Print pane. 

 

Fig. 5.84 (Page  Orie ntation: Portrait Or Lands cape ) 
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 Select either Portrait Orientation or Landscape Orientation from the orientation 

drop-down menu. 

 Page orientation for the worksheet will be changed. 

5.21.3 INSERTING AND REMOVING PAGE BREAKS 

There are two different kinds of page breaks in Excel: 

(i) Soft page breaks 

(ii) Hard page breaks 

A soft page break is automatically inserted into a spreadsheet when there is too much data 

to fit on one page. 

A hard page break is one that you can insert into a spreadsheet, wherever you want it to 

appear. 

To Insert a Page Break: 

 Move the cursor to the row where a page break needs to be inserted. This row will 

be the first row on the new page.  

 Click the Page Layout tab  Page Setup group  Breaks command  Insert Page 

Break option. 

 

Fig. 5.85 (Ins e rting a Page  Bre ak ) 

 A page break, indicated by a dashed line, is inserted into the worksheet. 

 You can go to Print Preview to confirm that it appears in the correct place on the 

page. 

To Remove a Page Break: 

 Move the cursor to the row where a page break appears. 
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 Click the Page Layout tab  Page Setup group  Breaks command  Remove 

Page Break option. 

 

Fig. 5.86 (Re m oving a Page  Bre ak ) 

 The page break (represented by a dashed line) is removed from the page. 

 5.22  GRAPHICAL REPRESENTATION OF DATA 

Charts (also known as graphs) are a visual representation of data in a worksheet. Charts 

allow you to present data entered into the worksheet in a visual format using a variety of 

graph types. Charts make it easy to see comparisons, patterns, and trends in data. It 

includes the design area, gridlines, and values. By using elements such as columns (in a 

column chart) or lines (in a line chart), a chart displays series of numeric data in a graphical 

format. It works by drawing figures that would represent numbers, adding colors and 

shapes to the information presented. 

The graphical format of a chart makes it easier to understand large quantities of data 

and the relationship between different series of data. A chart can also show the big picture 

so that you can analyze your data and look for important trends. 

5.22.1 ORGANIZING CHARTS AND GRAPHS 

Before to create a chart, you must have some numeric data values stored in the cells of a 

worksheet. Normally, the data that a chart uses can reside in a single worksheet, or in 

multiple worksheets. 

5.22.1.1 COMPONENTS OF A CHART 

In Excel, a chart comprises of following components: 
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Fig. 5.87 (Com pone nts  of a Ch art) 

 Source Data 

 This is the range of cells that make up a chart. The chart is updated automatically 

whenever the information in these cells changes. 

 Title 

 This is the title of the chart. 

 Legend 

 This is the chart key, which describes what each color on the chart represents. 

 Axis 

 This is the vertical and horizontal parts of a chart. The vertical axis is often referred 

to as the Y axis, while the horizontal axis is referred to as the X axis. 

 Data Series 

 This is the actual charted values, which usually are rows or columns of the source 

data. 

 Value Axis 

 This is the axis that represents the values or units of the source data. 

 Category Axis 

 This is the axis identifying each data series. 
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5.22.1.2 TYPES OF CHARTS 

Excel allows you to create different kinds of charts or graphs. 

 AREA CHART 

 Area chart emphasizes the trend of each value over time. An area chart also shows 

the relationship of parts to a whole. 

 

Fig. 5.88 (Are a Ch art) 

 COLUMN CHART 

 Column chart uses vertical bars or columns to represent data. They can work with 

many different types of data, but they are most frequently used for comparing 

information. 

 

Fig. 5.89  (Colum n Ch art) 

 BAR CHART 

 Bar chart is similar to a column chart except these use horizontal instead of vertical 

bars. Like the column chart, the bar chart shows variations in value over time. 
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Fig. 5.9 0 (Bar Ch art) 

 LINE CHART 

 Line chart shows trends and variations in data over time. A line chart displays a 

series of points, called data points that are connected over time. The data points are 

connected with lines, making it easy to see whether values are increasing or 

decreasing over time. 

 
Fig. 5.9 1 (Line  Ch art) 

 PIE CHART 

 Pie chart displays the contribution of each value to the total. Pie charts are a very 

effective way to display information when you want to represent different parts of 

the whole, or the percentages of a total. In Pie chart, each value is shown as a slice of 

the pie, so it is easy to see which values make up the percentage of a whole. 

 

Fig. 5.9 2 (Pie  Ch art) 
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5.22.1.3 EMBEDDED CHART 

Embedded charts are charts that reside in the same worksheet as the source data i.e. if a 

chart resides in a worksheet along with worksheet data, then that kind of chart is called an 

embedded chart. 

In Excel, either you can print an embedded chart as part of the data on the worksheet or 

you can print an embedded chart by itself without the supporting worksheet data i.e. you 

can print embedded charts only one by one by selecting the charts from the worksheet. 

An Excel Chart Sheet is a worksheet tab that only contains the Excel charts.  Thus, it is 

called a Chart Sheet. You can place more than one chart on a chart sheet. 

5.22.1.3.1 CREATING A CHART / EMBEDDED CHART 

To create a chart or an embedded chart, you must first enter the data into a worksheet. 

This section explains how you can create simple embedded charts from the data. 

To Create a Chart: 

 First of all, enter the data into the worksheet and highlight all the cells that will be 

included in the chart including the column titles and the row labels. These cells will be 

the source data for the chart. 

 

Fig. 5.9 3 (H igh ligh t th e  ce lls  th at w ill be  include d in th e  ch art) 

 Click the Insert tab. In the Charts group, select the desired Chart Category (say-

Column). 

 

Fig. 5.9 4 (Se le cting Ch art Cate gory) 
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 Select the desired Chart type from the drop-down menu (say- Clustered Column). 

 

Fig. 5.9 5 (Se le cting Ch art Type  Unde r Ch art Cate gory) 

 The chart will appear in the worksheet. 
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Fig. 5.9 6 (Ch art) 

5.22.1.4 CHANGING CHART TYPES 

To Change the Chart Type: 

 Select the chart and click the Design tab. In the Type group, click the Change Chart 

Type command.  
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Fig. 5.9 7 (Ch art: Ch ange  Ch art Type  Com m and) 

 Change Chart Type dialog box appears.  

 

Fig. 5.9 8 (Ch ange  Ch art Type  Dialog box) 

 Select the desired chart type, and then click OK. 

 5.23  SORTING 

A spreadsheet can contain a huge amount of information. With more rows and columns 

than previous versions, Excel 2010 gives you the ability to analyze and work with an 

enormous amount of data. To most effectively use this data, you may need to manipulate 

this data in different ways. Sometimes you may find that you need to reorder or sort that 

information to be able to use it most effectively. 

Sorting or Data Sorting is a common spreadsheet task that allows you to easily reorder 

your data. The most common type of sorting is alphabetical ordering, which you can do in 

ascending or descending order.  

To Sort in Alphabetical Order: 

 Select a cell in the column you want to sort (In Figure 5.99, we choose a cell in 

column A). 
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Fig. 5.9 9  (Sorting: Se le ct a Ce ll from  th e  Colum n) 

 Click the Sort & Filter command in the Editing group on the Home tab. Select Sort 

A to Z. 

 

Fig. 5.100 (Sort &  Filte r: Sort A to Z ) 

 Now, the data in the spreadsheet will be organized alphabetically. 

 

Fig. 5.101 (Sorte d Lis t) 

Note: You can sort in reverse alphabetical order by choosing Sort Z to A in the list. 
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To Sort in Numerical Order: 

 Select a cell in the column you want to sort (a column with numbers). 

 
Fig. 5.102 (Sorting: Se le ct a Ce ll from  th e  Colum n) 

 Click the Sort & Filter command in the Editing group on the Home tab. Select Sort 

Smallest to Largest.  

 
Fig. 5.103 (Sorting: Sort Sm alle s t to Large s t) 

 Now, the data in the spreadsheet will be organized numerically from the smallest to 

largest value. 

 
Fig. 5.104 (Sorte d Lis t) 

Note: You can sort in reverse numerical order by choosing Sort Largest to Smallest in 

the list. 
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To Sort by Date or Time: 

 Select a cell in the column you want to sort. 

 

Fig. 5.105 (Sorting: Se le ct a Ce ll from  th e  Colum n) 

 Click the Sort & Filter command in the Editing group on the Home tab. Select Sort 

Oldest to Newest.  

 

Fig. 5.106 (Sorting: Sort Olde s t to Ne w e s t) 

 Now, the data in the spreadsheet will be organized by date or time. 

 

Fig. 5.107 (Sorte d Lis t) 

Note: You can sort in reverse Date or Time order by choosing Sort Newest to Oldest in the 

list. 
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 5.24  FILTERING 

Filtering is a convenient and reliable way to locate and manage spreadsheet data. This 

allows you to focus on specific spreadsheet entries. Filtered data can be copied, 

manipulated, and printed without having to move it to a new spreadsheet.  

Data filtering in Excel enables the user to work with a subset of data within the data list. 

When a filter is created, only the records that contain the values specified are displayed. 

Other records in the data list are hidden temporarily. 

Unlike sorting, filtering does not rearrange a list. Filtering temporarily hides rows you 

do not want displayed. 

Filtering in Excel: 

In Excel 2010, filtering, or temporarily hiding data in a spreadsheet is very easy. You can 

filter data using the AutoFilter feature in Excel 2010 to display only the data that meets 

specified criteria. 

To Filter Data: 

 Open the spreadsheet in which you want to filter data. 

 

Fig. 5.108 (Filte ring: Spre ads h e e t for Filte ring) 

 Prepare your data for an Excel 2010 AutoFilter: Excel can filter the data in all selected 

cells within a range, as long as there are no completely blank rows or columns within 

the selected range. Once a blank row or column is encountered, filtering stops. If the 

data in the range you wish to filter is separated by blank rows or columns, remove 

them before proceeding with the AutoFilter.  

 Conversely, if there is data on the worksheet that you do not want to be part of the 

filtered data, separate that data using one or more blank rows or blank columns. If 
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the data you don't want to filter is located beneath the data to be filtered, use at least 

one completely blank row to end filtering. If the data you don't want to filter is 

located to the right of data to be filtered, use a completely blank column. 

 Select any cell within the range that you would like to filter. 

 

Fig. 5.109  (Filte ring: Se le ct any Ce ll w ith in th e  Range  for Filte ring) 

 Select Filter command in Sort & Filter group under Data tab. 

 

Fig. 5.110 (Filte r Com m and) 

 Drop-down arrows will appear at the top of each column range. If the range of cells 

contains column headings, the drop-down arrows will appear in the headings. 

 

Fig. 5.111 (Filte ring: Drop-dow n arrow s  at th e  top of e ach  colum n) 
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 Click the drop-down arrow of the column containing the desired criteria to be 

filtered. Do the following tasks:  

(a) To filter the data by criteria, click to clear the “(Select All)” check box. All 

other check boxes will be cleared. Click to select the check boxes of the criteria 

that you want to appear in the filtered list.  

 

Fig. 5.112 (Filte ring: Filte r Data by Crite ria) 

(b) Click "OK" to filter the range by the selected criteria. The filtered result will be 

look like this: 

 

Fig. 5.113 (Filte ring: Filte re d Data) 

 5.25  PROTECTING WORKSHEETS 

Protecting worksheets in Excel can help safeguard your data and prevent unauthorized 

changes. 

To Protect a Worksheet: 

 Open the workbook containing the worksheet you want to protect. 
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 Select the worksheet: Click on the worksheet tab to select the specific worksheet you 

want to protect. If you want to protect multiple worksheets, hold down the Ctrl key 

while selecting multiple tabs. 

 In the Excel ribbon at the top of the window, click on the "Review" tab. 

 In the "Changes" group, click on the "Protect Sheet" button. 

 

Fig. 5.114 (Prote ct Sh e e t) 

 Protect Sheet dialog box will appear. 

 

Fig. 5.115 (Prote ct Sh e e t Dialog Box) 

 In the "Protect Sheet" dialog box, you can choose various protection options, such as 

allowing or disallowing certain actions like- selecting cells, formatting cells, inserting or 

deleting rows/columns, etc. You can also set a password to prevent others from 

unprotecting the sheet without the password. 

 After configuring the desired protection options, click the "OK" button. The selected 

worksheet(s) will be protected. 
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 5.26  CONTROLLING WORKSHEETS VIEWS 

Controlling worksheet views in Excel allows you to customize the appearance and 

settings of specific worksheets within a workbook. This can be helpful for organizing and 

presenting data in a clear and concise way. 

There are several ways to control worksheet views in Excel. Here are a few of the most 

common methods: 

5.26.1 Hiding and Unhiding Rows and Columns 

You can hide rows and columns to temporarily remove them from view. 

To Hide a Row/Column: 

 To hide a row or a column in a worksheet, click a row or column heading to select it. 

 Then, right-click within the row or column and select Hide from the shortcut menu 

that appears. 

 

Fig. 5.116 (H iding Row  / Colum n) 

To Display a Hidden Row/Column: 

 To unhide the row or column, right-click the border between the hidden item and 

rows or columns that are visible. 
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Fig. 5.117 (Unh iding Row  / Colum n) 

 Select Unhide from the shortcut menu. 

5.26.2 Freezing Rows and Columns 

When you are working with a lot of data, it can be difficult to compare one or more rows 

with others that are towards the bottom of the workbook. Excel's freeze panes feature solves 

this problem by letting you lock specific rows or columns so they are always visible when 

you scroll. 

To keep row and column labels or other data visible as you scroll through a sheet, you can 

freeze the rows and/or columns. The frozen rows and columns don't scroll but remain visible 

as you move through the rest of the worksheet. 

To Freeze Row(s): 

 Select the row right below the row or rows you want to freeze. For example, if you 

want row 1 to always appear at the top of the worksheet even as you scroll, then 

select row 2. 

 

Fig. 5.118 (Fre e z e  Row (s )) 
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 Click the View tab  Windows group  Freeze Panes command. A drop-down 

menu appears. Select Freeze Panes. 

 

Fig. 5.119  (Fre e z e  Pane s  Com m and) 

 A black line appears below the row that is frozen in place. Scroll down in the 

worksheet to see the rows below the frozen rows. 

 

Fig. 5.120 (W ork s h e e t W indow  w ith  Row  1 Froz e n) 

To Freeze Column(s): 

 Select the column to the right of the columns you want frozen. For example, if you 

want column A to always appear to the left of the worksheet even as you scroll, select 

column B. 
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Fig. 5.121 (Fre e z e  Colum n(s )) 

 Click the View tab  Windows group  Freeze Panes command. A drop-down 

menu appears. Select Freeze Panes. 

 
Fig. 5.122 (Fre e z e  Pane s  Com m and) 

 A black line appears to the right of the frozen area. Scroll across the worksheet to see 

the columns to the right of the frozen columns. 

 
Fig. 5.123 (W ork s h e e t W indow  w ith  Colum n A Froz e n) 
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To Unfreeze Panes: 

 Click the View tab  Windows group  Freeze Panes command. A drop-down 

menu appears. Select Unfreeze Panes. 

 

Fig. 5.124 (Unfre e z e  Pane s ) 

5.26.3 SPLITTING SCREEN  

Microsoft Excel allows you to split the worksheet window into separate panes on the 

same worksheet. This allows you to work on different areas of a spreadsheet without having 

to scroll between them. You can split the screen horizontally, vertically or both for up to 

four different panes. 

Split Box is used to split the screen vertically and/or horizontally into sections allowing 

you to see multiple copies of a worksheet. 

Use the Split Box located at the top of the vertical scroll bar (horizontal split) or the far 

right end of the horizontal scroll bar (vertical split) to divide the screen into two parts. 

 

Fig. 5.125 (Split Boxe s ) 

Note: Splitting the screen is an alternative to freeze panes to keep worksheet titles or 

headings on screen as you scroll. 

To Split a Worksheet into two Horizontal Panes: 

 Place the mouse pointer over the split box above the vertical scroll bar. 
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 The mouse pointer will change to a double - headed black arrow when you are over 

the split box. (Fig. 5.126) 

 

Fig. 5.126 (Mous e  pointe r ove r Split Box) 

 When the mouse pointer changes, click and hold down the left mouse button. 

 A dark horizontal line will appear above row one of the worksheets. 

 Drag the mouse pointer downward. The dark horizontal line will follow the mouse 

pointer. (Fig. 5.127) 

 

Fig. 5.127 (Dark  H oriz ontal line  follow s  th e  Mous e  Pointe r) 
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 Release the mouse button and the screen will be split into two views, each with its 

own vertical scroll bar. 

 Now, above and below the horizontal split bar, there will be two copies of the 

worksheet. (Fig. 5.128) 

 

Fig. 5.128 (H oriz ontal Split Bar) 

To Split a Worksheet into two Vertical Panes: 

 Place the mouse pointer over the split box to the right of the horizontal scroll bar. 

 The mouse pointer will change to a double - headed black arrow when you are over 

the split box. (Fig. 5.129) 

 

Fig. 5.129  (Mous e  pointe r ove r Split Box) 

 When the mouse pointer changes, click and hold down the left mouse button. 
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 A dark vertical line will appear, running up the page. Drag the mouse to the left and 

this line will follow. (Fig. 5.130) 

 

Fig. 5.130 (Dark  Ve rtical line  follow s  th e  Mous e  Pointe r) 

 Release the mouse button and the screen will be split into two views, each with its 

own horizontal scroll bar.  

 Now, before and after the vertical split bar, there will be two copies of the 

worksheet. (Fig. 5.131) 

 

Fig. 5.131 (Ve rtical Split Bar) 

Note: To restore a window that has been split into two scrollable areas, double-click any 

part of the split bar that divides the panes. 
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 5.27  NAMING CELLS AND CELL RANGES 

By assigning meaningful names to cells or ranges, you can make it easier to understand 

and reference them in formulas and calculations. Additionally, named ranges can be used to 

create dynamic charts and tables that automatically update when the underlying data 

changes. 

Naming Cells: 

To name a cell in Excel, follow these steps: 

1. Select the cell you want to name. 

2. Click on the Name box located to the left of the formula bar. 

3. Enter a descriptive name for the cell. 

4. Press Enter to save the name. 

Naming Cell Ranges: 

To name a range of cells in Excel, follow these steps: 

1. Select the range of cells you want to name. 

2. Click on the Name box located to the left of the formula bar. 

3. Enter a descriptive name for the range. 

4. Press Enter to save the name. 

5.27.1 Benefits of Naming Cells and Cell Ranges 

Here are some of the benefits of naming cells and cell ranges in Excel: 

 Improved readability: Named cells and ranges make your spreadsheets easier to 

read and understand. 

 Easier to reference: You can use named cells and ranges in formulas instead of cell 

references, which makes your formulas more readable and easier to maintain. 

 Dynamic charts and tables: You can use named ranges to create dynamic charts and 

tables that automatically update when the underlying data changes. 

 Error prevention: Named cells and ranges can help to prevent errors by making it 

less likely that you will enter an incorrect cell reference in a formula. 

5.27.2 Working with Cell Ranges 

A cell is a single element in a worksheet that can hold a value, some text, or a formula. A 

cell is identified by its address, which consists of its column letter and row number. For 

example, cell E9 is the cell in the fifth column and the ninth row. 
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A range is a group or block of cells in a worksheet that have been selected or 

highlighted. When cells have been selected, they are surrounded by an outline or border.  

Normally there is only one cell in the worksheet with a black outline. This is the Active 

cell. Whatever command is executed by Excel affects the active cell.  

 

Fig. 5.132 (Active  Ce ll) 

Using the mouse, keyboard or Name Box, more than one cell can be selected to create a 

range, and commands executed by Excel will affect the entire range.  

Ranges can be made up of adjacent or non-adjacent cells. Adjacent cells are all together. 

There are no gaps in the range. Non-adjacent cell ranges consist of two or more separate 

blocks of cells. These blocks can be separated by rows or columns. For non-adjacent ranges, 

a block of cells can be of any size – from one to several hundred or even a thousand or more.  

A range consisting of adjacent cells can be created by dragging with the mouse. A range 

of adjacent cells as seen in the Fig. 5.133 would be B1:B9. 

Th e  Range  for th e
SUM function is  B1
to B9 .

 

Fig. 5.133 (Range  of Adjace nt Ce lls ) 

Ranges consisting of non-adjacent cells can be created by using the mouse and keyboard. 
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To Create a Range consisting of non-adjacent cells: 

 Click on the first cell you want to select with the mouse pointer to make it the active 

cell. 

 Release the mouse button. 

 Press and hold down the Ctrl key on the keyboard. 

 Click on the rest of the cells you want to select them without releasing the Ctrl key. 

 Once all the desired cells are selected, release the Ctrl key. 

 Do not click anywhere else with the mouse pointer once you release the Ctrl key or 

you will clear the highlight from the selected cells. 

 If you release the Ctrl key too soon and wish to highlight more cells, simply press 

and hold down the Ctrl key again and then click on the additional cell(s). 

 

Fig. 5.134 (Range  of Non-adjace nt Ce lls ) 

Ranges are identified by the cell references or addresses of the cells in the upper left and 

lower right corners of the range. These two references are separated by a colon (:) which 

tells Excel to include all the cells between these start and end points. 

 

Short Answer Questions 

Q1.  W h at is  Spre ads h e e t 

                          Or 

 De fine  W ork s h e e t.                                                                      

Ans :  Spre ads h e e t or W ork s h e e t is  a docum e nt th at s tore s  data in a grid of h oriz ontal row s  and 
ve rtical colum ns . Row s  are  typically labe le d us ing num be rs  (1, 2, 3, e tc.), w h ile  colum ns  are  
labe le d w ith  le tte rs  (A, B, C, e tc). Individual row /colum n locations , s uch  as  C3 or B12, are  
re fe rre d to as  ce lls . 



 Spreadsheets  5.111   

 In a s pre ads h e e t application, e ach  value  s its  in a ce ll. You can de fine  w h at type  of data is  in 
e ach  ce ll and h ow  diffe re nt ce lls  de pe nd on one   anoth e r.  

Q2.  De fine  Spre ads h e e t Softw are .             

Ans :  Spre ads h e e t s oftw are  allow s  us e rs  to pe rform  calculations  on th e  data. Th e s e  are  com pute r 
program s  th at allow  th e  us e r to cre ate  and m anipulate  s pre ads h e e ts  e le ctronically. Micros oft 
Exce l is  s pre ads h e e t s oftw are  in th e  Micros oft Office  Suite  w ide ly us e d to pe rform  
m ath e m atical calculations . Th e  data is  s pre ad in a tabular form  cons is ting of row s  and 
colum ns . It provide s  built-in fe ature s  and tools  s uch  as  form ulas , functions  and data analys is  
tools  th at m ak e  it e as ie r to w ork  w ith  large  am ount of data. 

Q3.  Brie fly e xplain w ork s h e e t, w ork book  and ce ll. 

Ans :  A worksheet is  th e  grid of ce lls  w h e re  you can type  th e  data. Th e  grid divide s  your 
w ork s h e e t into row s  and colum ns . Colum ns  are  ide ntifie d w ith  le tte rs  (A, B, C ….), w h ile  row s  
are  ide ntifie d w ith  num be rs  (1, 2, 3 ….). 

Th e  w ork s h e e ts  in turn are  groupe d toge th e r into a workbook. By de fault e ach  w ork book  in 
Exce l contains  3 blank  w ork s h e e ts , w h ich  are  ide ntifie d by tabs  (s h e e t1, s h e e t2 and s h e e t3) 
dis playing along th e  bottom  of your s cre e n. 

Cells are  th e  bas ic building block s  of a w ork s h e e t. Each  re ctangle  in a w ork s h e e t is  calle d a 
ce ll. A ce ll is  th e  inte rs e ction of a row  and a colum n i.e . a ce ll is  ide ntifie d by colum n and 
row . Each  ce ll h as  a nam e , or a ce ll addre s s  bas e d on w h ich  colum n and row  it inte rs e cts . 

Q4. W h at are  th e  fe ature s  of MS-Exce l?                                                    

Ans : MS-Exce l h e lps  us  to: 

 Arrange  data in an organiz e d w ay 

 Pe rform  m ath e m atical calculations  

 Com pare  data th rough  ch arts  

 Sort data for be tte r analys is  

 Com pare  tw o w ork book s  s ide  by s ide  

Q5.  W h at is  Range  in MS-Exce l?  

Ans : A range  is  a group or block  of ce lls  in a w ork s h e e t th at h ave  be e n s e le cte d or h igh ligh te d. 
W h e n ce lls  h ave  be e n s e le cte d th e y are  s urrounde d by an outline  or borde r.  

Norm ally th e re  is  only one  ce ll in th e  w ork s h e e t w ith  a black  outline . Th is  is  th e  Active  ce ll. 
W h ate ve r com m and is  e xe cute d by Exce l affe cts  th e  active  ce ll.  

 
(Active  Ce ll) 

Us ing th e  m ous e , k e yboard or Nam e  Box, m ore  th an one  ce ll can be  s e le cte d to cre ate  a 
range , and com m ands  e xe cute d by Exce l w ill affe ct th e  e ntire  range .  

Range s  can be  m ade  up of adjace nt or non-adjace nt ce lls . Adjace nt ce lls  are  all toge th e r. 
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Th e re  are  no gaps  in th e  range . Non-adjace nt ce ll range s  cons is t of tw o or m ore  s e parate  
block s  of ce lls . Th e s e  block s  can be  s e parate d by row s  or colum ns . 

Q6.  De fine  Form ulas  in Exce l. 

Ans : Form ulas  are  e q uations  th at pe rform  calculations  on data value s  in th e  w ork s h e e t. Lik e  a 
calculator, Exce l can e xe cute  form ulas  th at add, s ubtract, m ultiply, and divide . A form ula can 
be  a com bination of cons tant value s , ce ll re fe re nce s  and m ath e m atical ope rators  (+ , -, /, *, =). 

A form ula s tarts  w ith  an e q ual s ign (=). 

Example: 

Th e  follow ing form ula m ultiplie s  5 by 10 and th e n adds  th e  value  in ce ll A2 to th e  re s ult: 

=A2+ 5*10 

Q7.  W rite  a note  on Ch art.                                                                   

Ans : Ch arts  (als o k now n as  graph s ) are  a vis ual re pre s e ntation of data in a w ork s h e e t. Ch arts  
allow  you to pre s e nt data e nte re d into th e  w ork s h e e t in a vis ual form at us ing a varie ty of 
graph  type s . Ch arts  m ak e  it e as y to s e e  com paris ons , patte rns , and tre nds  in data. 

Be fore  to cre ate  a ch art, you m us t h ave  s om e  num e ric data value s  s tore d in th e  ce lls  of a 
w ork s h e e t. Norm ally, th e  data th at a ch art us e s  can re s ide  in a s ingle  w ork s h e e t, or in 
m ultiple  w ork s h e e ts . 

Q8.  H ow  data filte r h e lps  to m anage  and locate  s pre ads h e e t data e ffe ctive ly? 

Ans :   Filte ring is  a conve nie nt and re liable  w ay to locate  and m anage  s pre ads h e e t data. Th is  
allow s  you to focus  on s pe cific s pre ads h e e t e ntrie s . Filte re d data can be  copie d, 
m anipulate d, and printe d w ith out h aving to m ove  it to a ne w  s pre ads h e e t.  

Data filte ring in Exce l e nable s  th e  us e r to w ork  w ith  a s ubs e t of data w ith in th e  data lis t. 
W h e n a filte r is  cre ate d, only th e  re cords  th at contain th e  value s  s pe cifie d are  dis playe d. 
Oth e r re cords  in th e  data lis t are  h idde n te m porarily. 

Unlik e  s orting, filte ring doe s  not re arrange  a lis t. Filte ring te m porarily h ide s  row s  you do not 
w ant dis playe d. 

Q9 .  W h at is  Em be dde d Ch art?                                                                    

Ans :   Em be dde d ch arts  are  ch arts  th at re s ide  in th e  s am e  w ork s h e e t as  th e  s ource  data i.e . if a 
ch art re s ide s  in a w ork s h e e t along w ith  w ork s h e e t data, th e n th at k ind of ch art is  calle d an 
e m be dde d ch art. 

Q10.  W rite  about Fill Tool and Fill Se rie s . 

Ans :   Fill tool is  a w ay to duplicate  e xis ting conte nt. It bas ically h e lps  you fill in s e q ue ntial data 
w ith out h aving to type  in e ve ry ce ll. 

A m ore  com ple x us e  of th e  Fill Tool is  to us e  a Fill Se rie s . Th e  de fault lis ts  are  for th e  full and 
abbre viate d days  of th e  w e e k  and th e  m onth s  of th e  ye ar, but you can cre ate  your ow n lis ts  
as  w e ll. 

Q11.  Dis cus s  m e nus  and toolbars  in Exce l 2010.                                       

Ans :   In Exce l 2010, m e nus  and toolbars  h ave  be e n re place d by th e  tabbe d Ribbon s ys te m . Ribbon 
is  a com bination of m e nu bar and tool bar. Th e  Ribbon is  de s igne d to h e lp you q uick ly find 
th e  com m ands  th at you ne e d to com ple te  a tas k . Com m ands  are  organiz e d in logical groups , 
w h ich  are  colle cte d toge th e r unde r tabs . 

Q12.  W h at is  Payroll State m e nt?                                                                  

Ans :    Payroll is  th e  s um  total of all com pe ns ation a bus ine s s  m us t pay to its  e m ploye e s  for a s e t 
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pe riod of tim e  or on a give n date . It is  us ually m anage d by th e  accounting de partm e nt of a 
bus ine s s ; s m all-bus ine s s  payrolls  m ay be  h andle d dire ctly by th e  ow ne r or an as s ociate . 

Q13.  Explain Look up function.                                                                      

                           Or 

 Dis cus s  th e  us e s  of look up and re fe re nce  function in s pre ads h e e t. 
Ans :      Re fe r s e ction 5.17.7 

Q14.  W rite  s te ps  for ins e rting and re m oving page  bre ak s  in MS-Exce l.   

Ans :      To Ins e rt a Page  Bre ak : 

 Move  th e  curs or to th e  row  w h e re  a page  bre ak  ne e ds  to be  ins e rte d. Th is  row  w ill be  th e  
firs t row  on th e  ne w  page .  

 Click  th e  Page  Layout tab  Page  Se tup group  Bre ak s  com m and  Ins e rt Page  
Bre ak  option. 

 A page  bre ak , indicate d by a das h e d line , is  ins e rte d into th e  w ork s h e e t. 

 You can go to Print Pre vie w  to confirm  th at it appe ars  in th e  corre ct place  on th e  page . 

 To Re m ove  a Page  Bre ak : 

 Move  th e  curs or to th e  row  w h e re  a page  bre ak  appe ars . 

 Click  th e  Page  Layout tab  Page  Se tup group  Bre ak s  com m and  Re m ove  Page  
Bre ak  option. 

 Th e  page  bre ak  (re pre s e nte d by a das h e d line ) is  re m ove d from  th e  page . 

Long Answer Questions 

Q1. W h at is  Spre ads h e e t? Explain th e  m ain fe ature s  of MS-Exce l.  

Or 

 W h at is  Spre ads h e e t? Explain th e  m ain fe ature s  of a s pre ads h e e t pack age . 

Ans : Re fe r s e ction 5.1 &  5.1.1 

Q2. W h at is  Spre ads h e e t? Explain diffe re nt k inds  of m ath e m atical and s tatis tical functions  
w ith  e xam ple .                                                                                                 

Ans : Re fe r Se ction 5.1, 5.17.1 &  5.17.2 

Q3.  W h at are  diffe re nt cate gorie s  of Ch arts ? W rite  th e  s te ps  to cre ate  a ch art in MS-Exce l. 

Ans :  Re fe r s e ction 5.22.1.2 &  5.22.1.3.1 

Q4.  De fine  Ce ll Re fe re ncing. Explain re lative , m ixe d and abs olute  ce ll re fe re ncing w ith  
e xam ple .  

Ans :  Re fe r Se ction 5.16 

Q5. H ow  functions  m ak e  tas k s  e as y in Exce l? Explain diffe re nt k inds  of m ath e m atical and 
s tatis tical functions  w ith  e xam ple .                                                                        

Ans : Re fe r Se ction 5.17, 5.17.1 &  5.17.2 

Q6. Dis cus s  th e  m ath e m atical form ulae  of SUM, SUBTOTAL, PRODUCT, and AVERAGE in 
a s pre ads h e e t in de tail.  

Ans : Re fe r Se ction 5.17.1 

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